The following release information applies to this version of the *Scaffold PTM User’s Manual*. This document is applicable for Scaffold PTM, Release 3.3 or greater, and is current until replaced.

<table>
<thead>
<tr>
<th>Document Version Number</th>
<th>Scaffold PTM-UG_3.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Status</td>
<td>Released</td>
</tr>
<tr>
<td>Document Release Date</td>
<td>July 1, 2019</td>
</tr>
</tbody>
</table>

© 2019. Proteome Software, Inc., All rights reserved.

The information contained herein is proprietary and confidential and is the exclusive property of Proteome Software, Inc. It may not be copied, disclosed, used, distributed, modified, or reproduced, in whole or in part, without the express written permission of Proteome Software, Inc.

Proteome Software, Inc. has used their best effort in preparing this guide. Proteome Software, Inc. makes no representations or warranties with respect to the accuracy or completeness of the contents of this guide and specifically disclaims any implied warranties of merchantability or fitness for a particular purpose. Information in this document is subject to change without notice and does not represent a commitment on the part of Proteome Software, Inc. or any of its affiliates. The accuracy and completeness of the information contained herein and the opinions stated herein are not guaranteed or warranted to produce any particular results, and the advice and strategies contained herein may not be suitable for every user.

The software described herein is furnished under a license agreement or a non-disclosure agreement. The software may be copied or used only in accordance with the terms of the agreement. It is against the law to copy the software on any medium except as specifically allowed in the license or the non-disclosure agreement.

The name *Proteome Software*, the Proteome Software logo, *Scaffold, Scaffold Q+, Scaffold Q+S, Scaffold PTM, Scaffold perSPECtives and Elements for Metabolomics* and the Scaffold, Scaffold Q+, Scaffold Q+S, Scaffold PTM, Scaffold perSPECtives and Elements for Metabolomics logos are trademarks or registered trademarks of Proteome Software, Inc. All other products and company names mentioned herein may be trademarks or registered trademarks of their respective owners.

SEQUEST is a registered trademark of the University of Washington. Mascot is a registered trademark of Matrix Science Ltd. X! Tandem is used by agreement with Beavis. Informatics Inc. ProteinProphet is a registered trademark and PeptideProphet is a trademark of the Institute for Systems Biology. The Gygi Lab has published a number of papers using the Ascore algorithm and a number of papers using the motif identification algorithm.

Customer Support

Customer support is available to organizations that purchase Scaffold, Scaffold Q+, Scaffold Q+S, Scaffold PTM, Scaffold perSPECtives or Elements for Metabolomics and that have an annual support agreement.

Contact Proteome Software at:

Proteome Software, Inc.
1340 SW Bertha Blvd, Suite 10
Portland, OR 97219
1-800-944-6027 (Toll Free)
1-503-244-6027 (Direct)
1-928-244-6024 (FAX)
www.proteomesoftware.com
# Table of Contents

Preface ................................................................................................................................. 7

Chapter 1: Getting Started with Scaffold PTM ................................................................. 9

Chapter 2: PTM Analysis in Scaffold PTM ................................................................. 23

Chapter 3: Loading data in Scaffold PTM ................................................................. 37

Chapter 4: Scaffold PTM Main Window ........................................................................ 49

Chapter 5: The Organize View ......................................................................................... 75

Chapter 6: The PTM List View ......................................................................................... 81

Chapter 7: The Proteins View ......................................................................................... 91

Chapter 8: The Motifs View .......................................................................................... 103

Chapter 9: The Quantify View ......................................................................................... 113

Chapter 10: The Publish View ......................................................................................... 123

Chapter 11: Reports ....................................................................................................... 129

Appendix ............................................................................................................................. 135

A. Structure of Scaffold PTM files (*.sptm) ................................................................. 137
B. Terminology ................................................................................................................ 138
C. PTM Dynamic Quantitative Calculations .............................................................. 139
D. Context Menus - Right Click Commands ............................................................. 140
Preface

Using the manual

The Scaffold PTM User’s Manual has a dual purpose design. It can be distributed electronically and then printed on an as-needed basis, or it can be viewed on-line in its fully interactive capacity. If users print the document, for best results, it is recommended that they print it on a duplex printer; however, single-sided printing will also work. If users wish to view the document on-line, a standard set of bookmarks appears in a frame on the left side of the document window for navigation through the document. For better viewing, users can decrease the size of the bookmark frame and use the magnification box to adjust the magnification of the document to their viewing preference.

Conventions used in the manual

The Scaffold PTM User’s Manual uses the following conventions:

• Information that can vary in a command—variable information—is indicated by alphanumeric characters enclosed in angle brackets; for example, <ProteinName>.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “on-line friendly.” Pages are numbered from 1 to x, starting with the cover and ending on the last page of the index.

• This manual is intended for both print and on-line viewing.

• Although numbering begins on the cover page, this number is not visible on the cover page or front matter pages. Page numbers are visible beginning with the first page of the Table of Contents.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries are also hyperlinks. Click the hyperlink to advance to the referenced information.

• A sample set of Demo data, available for download from www.proteomesoftware.com/products/demo-data/#ptm/ is used as the basis for most screen captures, examples, and data manipulations that are shown in the manual.

If users do print the document using a single-sided printer, they might see a single blank page at the end of some chapters. This blank page has been added solely to ensure that the next chapter begins on an odd-numbered page. This blank page in no way indicates that the book is missing information.
Assumptions in the manual

The Scaffold PTM User’s Manual assumes that:

• The user is familiar with Windows operating systems, and basic Windows navigational elements, content formatting and layout tools.

• The user has the appropriate licensing to run Scaffold PTM.


Organization of the manual

In addition to this Preface, the Scaffold PTM User’s Manual contains the following chapters:

• “Getting Started with Scaffold PTM” on page 9

• “PTM Analysis in Scaffold PTM” on page 23

• “Loading data in Scaffold PTM” on page 37

• “Scaffold PTM Main Window” on page 49

• “The Organize View” on page 75

• “The PTM List View” on page 81

• “The Proteins View” on page 91

• “The Motifs View” on page 103

• “The Quantify View” on page 113

• “The Publish View” on page 123

• “The Publish View” on page 123

• Appendix , on page 136.
Chapter 1
Getting Started with Scaffold PTM

This chapter introduces the user to the basic design of the program and its primary uses:
“Getting Started with Scaffold PTM” on page 10
Scaffold PTM is a computational tool that automates post-translational modification (PTM) site assignment in proteomic experiments. It analyzes MS/MS spectral output and provides researchers with an objective measure of the confidence of PTM (e.g., phosphorylation) site identifications. Scaffold PTM uses ASCORE’s probabilistic approach and scoring technique to annotate PTM sites contained in MS/MS spectra.

The Scaffold PTM Viewer is a free, read-only version of Scaffold PTM available online for download. It facilitates the sharing of Scaffold PTM analysis results among collaborators.

This chapter explains the licensing structure for the Scaffold PTM application. It also provides a brief description of the differences between products in the Scaffold Suite and a quick overview of the Scaffold PTM application.

- “Scaffold PTM initial requirements” on page 11 describes the requirements for installing and running Scaffold PTM.
- “Installing Scaffold PTM” on page 12 describes how to install the application.
- “Scaffold PTM Licensing” on page 13 explains the type of licenses available for activating the program.
- “Scaffold PTM highlights” on page 20 provides an overview of the tools included in the program.
- “Scaffold Suite of Products, Scaffold DIA and Scaffold Elements” on page 21 provides a brief comparison of the different lines of products offered by Proteome Software.
- “Referencing Scaffold PTM Results” on page 22 provides indications for referencing analyses performed with Scaffold PTM.
Chapter 1
Getting Started with Scaffold PTM

Scaffold PTM initial requirements

Before installing and running Scaffold PTM the user needs to make sure that:

1. The computer system where Scaffold PTM is to be installed and its network have access to directories containing:
   - mzIdentML files for the samples to be analyzed

2. Check the following document for general system requirement:
   System_requirements. Check the following document for general information on how to install the programs included in the Scaffold Suite: installation_guide.

3. Have a license key to run Scaffold PTM, see Scaffold PTM Licensing.

Once it is installed, to run Scaffold PTM, the user should:

4. Either select the menu option File > New or click the Create New Experiment icon in the Tool bar menu, to start queuing data files.

   When Scaffold PTM initially opens, the first-time user may wish to click the Run Demo button in the Welcome Scaffold PTM box. Then, open one of the previously saved tutorial files to begin by exploring an existing experiment. Guided tutorials are also available at the following link:

Chapter 1
Getting Started with Scaffold PTM

Installing Scaffold PTM

Scaffold PTM runs on Windows, MAC and Linux systems, see System Requirements. Follow these instructions to install the application on your system:

1. Download and launch the Scaffold PTM installation executable compatible with the computer system on which the program will be installed. See www.proteomesoftware.com/products/ptm/

2. Carefully follow the instructions provided in the installation wizard.

   Figure 1-1: Scaffold PTM installation Setup Wizard

3. During the initial installation, the user will be presented an opportunity to allocate memory to Scaffold PTM. For best performance, it is recommended that the user allocate as much memory as possible, up to about 80% of the system’s physical RAM.

4. When the installation is finished, the user is offered the option to open Scaffold PTM upon closing of the wizard.

   For better performance you should allocate a large portion of the RAM available on the installation system to Scaffold PTM. The memory can also be readjusted to a different value after installation by selecting the menu option Edit > Preferences - System tab. It is necessary to restart the program for these changes to take effect.
Scaffold PTM Licensing

The Scaffold PTM application is a standalone product that belongs to the Scaffold Suite of applications.

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scaffold</td>
<td>Visualize and validate MS/MS proteomics experiments.</td>
</tr>
<tr>
<td>Scaffold Q+</td>
<td>Calculate and display relative protein expression levels in a sample determined by tandem mass spectrometry of iTRAQ- or TMT-labeled proteins.</td>
</tr>
<tr>
<td>Scaffold Q+S</td>
<td>Calculate and display relative protein expression levels in a sample determined by tandem mass spectrometry of stable isotopically-labeled (for example, SILAC) proteins.</td>
</tr>
<tr>
<td>Scaffold PTM</td>
<td>Post-translational modification (PTM) site assignment in proteomic experiments.</td>
</tr>
</tbody>
</table>

After Scaffold PTM has been installed on a computer, a shortcut icon for the application is placed on the desktop. For Windows systems, an option is also available from the Start menu. Double-clicking the desktop icon launches Scaffold PTM, as does selecting the option from the Start menu.

*Figure 1-2: Scaffold PTM desktop icon*

The first time Scaffold PTM opens after installation, the Enter License Key dialog appears.
Two kinds of keys are available to activate the software:

- The Evaluation Key
- The Time-Based License key

**Evaluation key**—An evaluation key may be valid for a period of two to four weeks. A user can request a free evaluation key for any of the Scaffold applications at [www.proteomesoftware.com](http://www.proteomesoftware.com). The evaluation key can be used on an unlimited number of computers. Once the key is copied and pasted into the license key dialog, confirmation of its validity and the time remaining in the evaluation period appears in a message under the key. Pressing OK starts the application.
Each time Scaffold PTM is launched in evaluation mode, a message appears showing the remaining time available for evaluation, along with the option to enter a new key.

*Figure 1-5: Message appearing when launching an evaluation copy of Scaffold PTM*

**Time-Based License key**—a Time-Based License key allows the user to access all features of the software permanently. It only allows upgrades while the software is covered by a valid
support contract, however. Once the contract has expired, Scaffold PTM will continue to work but no new upgrades will be allowed unless the support contract is renewed.

The user must contact sales@proteomesoftware.com to purchase the appropriate key.

A Time-Based License key is valid for only a single computer. If the user moves the Scaffold PTM installation to a different computer, he/she can contact sales@proteomesoftware.com to transfer the key at no charge.

*Figure 1-6: Time-Based License key*

When the Time-Based License key is entered, pressing Register Key verifies its validity and a message appears describing the status of the key.

*Figure 1-7: Successful registration message*

Once the key is successfully registered pressing OK closes the dialog box and the Scaffold PTM Welcome message appears.
Figure 1-8: Scaffold PTM Welcome Window

From this window, the user can create a new experiment, open an existing experiment (*.sptm file), or work with the demonstration data that is provided with the Scaffold PTM installation.

Registering Time-Based License key with no INTERNET connection

When the user attempts to register a time-based license key with no INTERNET connection available, a warning message appears. If the computer where Scaffold PTM resides needs to be disconnected from the Internet, the user should copy the two character strings provided and paste them into an email, which should be sent to support@proteomesoftware.com. Please do not send a screen shot. A technical support representative at Proteome Software will promptly provide a pre-registered key that will unlock Scaffold PTM on the specific machine on which it is installed.

Figure 1-9: E-mail key request
Time-based license key renewal

Time-based license keys have time limits on their validity. When the user’s support contract expires, Scaffold PTM still works but upgrades are not allowed until the support contract is renewed. The status of a Scaffold PTM license key may be checked in the About Scaffold PTM... dialog which the user opens by selecting Help > About Scaffold PTM command from the main menu.

If the contract has expired and the user wants to upgrade Scaffold PTM, clicking the Renew button in the dialog opens the Key Reset Request page on the Proteome Software website. The user should fill in the request form and a sales representative will promptly contact him/her providing further information.
Scaffold PTM System Requirements

Minimum Requirements

Operating System
- Mac OS X (10.9 and higher)
- Linux: Ubuntu 9.x, 10.x, 11.x, 12.x, 13.x, 14.x, RHEL/CentOS 5.6 and higher.

RAM
- 2 GB usable RAM minimum (8 GB or more recommended)

Available Disk Space
- Hard Disk space (for temp, backup) should be no less than 5 times the amount of raw data being processed.

Recommended Requirements

Operating System
- Windows 7, 8 or 10, Mac OS X Latest or Linux (Ubuntu 12.04 or above)

RAM
- 8 GB usable RAM minimum (16 GB or more recommended)

Scaffold PTM 32-bit or 64-bit
- Scaffold PTM can handle many more spectra and much larger datasets if a 64-bit system is used. 32-bit and 64-bit installers are available for licensed and viewer programs.

Available Disk Space
- Hard disk space (for temp, backup) should be no less than 5 times the amount of raw data being processed.

Important Notes
- It is advisable to adjust the power settings to disable sleep or hibernate, as this might interfere with Scaffold PTM’s processing of data
- We recommend that you only install one version of Scaffold PTM on any one computer.
Scaffold PTM highlights

Scaffold PTM is a software tool designed to help researchers automate PTM site assignments and to provide a measure of confidence in PTM site identification. It also identifies potential enzyme recognition sites by scanning the dataset for overrepresented patterns in the amino acids surrounding modification sites.

Graphical Views

Once the data is searched and analyzed, the results are displayed in various graphical views. These views are designed to help the user examine the list of Post Translational Modifications protein by protein, perform visual inspections of the spectra, search for motifs, view quantitative results and gather all information needed for publication.

Organize

The Organize View lists all loaded MZID and SQML files and their associated MS Samples. From here, the user can add or delete files, toggle which of the MS Samples to analyze, and edit various identifying details.

Summarize

Three levels of summarization can easily be selected from Scaffold PTM’s main window, providing the ability to better evaluate PTM quantitative values.

Visualize

All identified proteins are listed in the PTM List table along with the number of PTM sites identified in each of them. Many specialized visualization tools are provided, such as:

- Proteins are grouped in the PTM List view.
- In the Proteins view, modifications are highlighted in different colors along the proteins sequence.
- In the Motifs view, motifs depicted in the sequence logo representation are colored according to their chemical properties and their size represents the frequency of the amino acid in a given position.

Statistical Tests

Statistical tests are included in the Quantify view when data is imported from Q+ or Q+S.

Publish

All of the information needed to reproduce the analysis is reported in the Publish View. In addition, a number of publication-quality graphics are available throughout the program.
Scaffold Suite of Products, Scaffold DIA and Scaffold Elements

Scaffold PTM belongs to the Scaffold Suite of products. While Scaffold Q+, and Scaffold Q+S are add-ons to the core Scaffold product, Scaffold PTM is a standalone application within the Scaffold Suite of applications and requires an independent license key provided by Proteome Software, see “Scaffold PTM Licensing” on page 13.

It processes mzIdentML (MZID) files which can be exported from other Scaffold Suite products or may be produced directly from a number of search engines, such as Mascot and PEAKS.

Scaffold Elements provides tools for analyzing MS raw data of relatively small molecules such as metabolites, lipids or glycans.

<table>
<thead>
<tr>
<th>Suite</th>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scaffold</td>
<td>Scaffold</td>
<td>Visualize and validate MS/MS proteomics experiments.</td>
</tr>
<tr>
<td></td>
<td>Scaffold Q+</td>
<td>Calculate and display relative protein expression levels in a sample determined by tandem mass spectrometry of iTRAQ- or TMT-labeled proteins.</td>
</tr>
<tr>
<td></td>
<td>Scaffold Q+S</td>
<td>Calculate and display relative protein expression levels in a sample determined by tandem mass spectrometry of stable isotopically-labeled (for example, SILAC) proteins.</td>
</tr>
<tr>
<td></td>
<td>Scaffold perSPECtives</td>
<td>Catalog, summarize and analyze complex large-scale experiments. Compare protein and peptide similarities and differences at any attribute group summarization level. Easily reorganize samples to compare the impact of tissue types, treatment types, demographic differences, experiment conditions and more.</td>
</tr>
<tr>
<td></td>
<td>Scaffold PTM</td>
<td>Scaffold PTM is a computational tool that, starting from MS/MS spectra of identified Post Translational Modification (PTM), allows the user to derive biologically relevant results in an automatic fashion reducing the amount of manual validation required to assure data integrity.</td>
</tr>
<tr>
<td>Elements</td>
<td>Scaffold Elements</td>
<td>Elements for Metabolomics is a software tool designed to help the researchers in the field of metabolomics to search and identify metabolites included in samples analyzed using liquid chromatography-mass spectrometry (LC-MS1 and MS2).</td>
</tr>
<tr>
<td>DIA</td>
<td>Scaffold DIA</td>
<td>Identify and quantify proteins using DIA proteomics.</td>
</tr>
</tbody>
</table>
Referencing Scaffold PTM Results

Users are free to copy, modify, and distribute the following examples when citing Scaffold PTM in their publications and reports.

Post Translational Modifications (PTM) Site Localization - Scaffold PTM (Proteome Software, Portland, Oregon, USA) was used to annotate PTM sites derived from MS/MS sequencing results obtained using <SEARCH_ENGINES>. Using the site localization algorithm developed by Sean A Beausoleil, Judit Villén, Scott A Gerber, John Rush & Steven P Gygi, Nature Biotechnology 24, 1285 - 1292 (2006), Scaffold PTM re-analyzes MS/MS spectra identified with modified peptides and calculates Ascore values and site localization probabilities to assess the level of confidence in each PTM localization. Scaffold PTM then combines localization probabilities for all peptides containing each identified PTM site to obtain the best estimated probability that a PTM is present at that particular site.

Motif Analysis - PTM were scanned for over-represented patterns in the amino acids surrounding the modification sites using the method described in Schwartz, D. & Gygi, SP (2005) Nature Biotechnology 23(11):1391-1398.
Chapter 2

PTM Analysis in Scaffold PTM

This chapter introduces the user to the primary functionality provided by this application:

- “Post Translational Modification Analysis in Scaffold PTM” on page 24
Scaffold PTM is a computational tool that automates post-translational modification (PTM) site assignment in proteomic experiments. It analyzes MS/MS spectral output and provides researchers with an objective measure of the confidence of PTM (e.g., phosphorylation) site identification.

The application also includes a motif extraction algorithm that identifies motifs surrounding PTM sites through iterative comparisons to a dynamic statistical background. This provides the means to identify potential enzyme recognition sites.

When used in conjunction with Scaffold Q+ or Q+S, Scaffold PTM also offers quantitative features to assess differential expression and modification among samples. When quantitative data exported from one of the Scaffold quantitative modules is loaded into Scaffold PTM, it computes the statistical significance of the fold change value for each modification site.

When protein levels exported from Scaffold Q+ or Q+S analysis of non-enriched samples are loaded along with the quantitative results for enriched samples, Scaffold PTM offers quantitative analysis of PTM activity by simultaneously considering protein- and site-level changes. This provides a more accurate measure of differential modification.

This chapter explains the following topics:

- “Automated PTM Site Localization in Scaffold PTM” on page 25, which provides a brief description of the algorithm used to confidently assign PTM sites.
- “Motif Identification” on page 27, which briefly describes the algorithm used to identify motifs surrounding PTMs.
- “Quantitative Statistics” on page 29, which describes new statistical features added to the Quantify View.
- “Quantitating PTM dynamics” on page 30, which describes an approach to quantify PTM expression when proteins levels change during the experiment.
- “Scaffold PTM Views” on page 32, which lists all of the data views included in Scaffold PTM.
Automated PTM Site Localization in Scaffold PTM

Scaffold-PTM uses ASCORE’s probabilistic approach and scoring technique to annotate modification sites contained in MS/MS spectra. Sequest, Mascot and similar peptide search engines that identify peptides may, as a side effect, identify peptides in which certain amino acid sites are modified. However, in cases in which the peptide contains multiple potential sites for the modification, they do not generally measure the likelihood that the PTM is located at one site rather than another. That task has traditionally been left to manual validation. As the size of experimental data sets has increased, and the importance of high-confidence PTM site recognition has grown, however, an automated validation tool has become essential.

In response to this need, the Ascore algorithm was developed in the Gygi lab at the Harvard Medical School’s Department of Cell Biology. The algorithm measures the probability of correct phosphorylation (or other PTM) site localization based on the presence and intensity of site-determining ions in MS/MS spectra and targets high-throughput PTM analysis and site localization.

Within the Scaffold-PTM environment, Ascore becomes an effective tool for automating large-scale, post-translational studies.

Using Ascore, Scaffold PTM re-analyzes results of previous searches done with Sequest, Mascot or other Scaffold-compatible search engines. The new analysis attempts to determine the likelihood that the location selected by the search engine is the best match in the observed spectrum for a PTM site. It graphically displays a list of the reported PTM sites and presents the evidence supporting the assignment of each PTM to its site.

By comparing site-determining ions, Scaffold PTM produces Ascore results, assigning an ambiguity score to each reported PTM site. The number of PTMs in each peptide can be determined by the precursor ion mass of the peptide’s spectrum. Scaffold PTM adds this knowledge to the Ascore to derive a site location probability and it then combines the site location probability estimates from all spectra matching peptides containing the site to obtain the best estimate of the probability that the PTM is at that site.

As a result, Scaffold PTM reduces the amount of manual validation required while improving data set integrity. Accurate determination of these sites removes an important bottleneck in proteomics and facilitates faster and more comprehensive analysis of PTM studies.

Critical for scientifically useful publication, the results derived from Scaffold PTM satisfy the requirements for acknowledgment of ambiguity.

Neutral Losses

The original Ascore calculation does not account for neutral losses that modified peptides

---


may undergo. In some cases, particularly with modifications such as O-GlcNac, in which the full mass of the modification may be lost, this results in treating peaks which are actually ambiguous as evidence for a particular localization. To better assess localization probability in the face of such ambiguity, Scaffold PTM (beginning with version 3.2) offers the option to use an extended version of the Ascore algorithm in which potential neutral loss peaks are accounted for in the calculations.

When this option is selected, the predicted fragmentation patterns used in the Ascore calculation include potential neutral loss peaks.

Two types of losses are considered:

- Neutral losses from modifications, as read from the modification specification in the input mzIdentML file.
- Water losses, only from unmodified S,T,E or D residues.

Doubly charged fragments are allowed if the precursor charge is greater than or equal to 2 and the fragment contains a basic residue.

Note that the neutral loss option does not affect ETD spectra, in which c and z ions are always considered, up to triply charged ions as the precursor charge state allows.
Motif Identification

Scaffold PTM’s motif analysis tool allows detailed investigation of statistically over-represented motifs identified in the experiment. That is, it allows the discovery of sequence motifs that are found to be modified more often than would be expected if modification sites were chosen randomly from all possible sites. Additionally, it allows for analysis of user-specified motifs to assess their prevalence.

Motif analysis algorithm

In order to identify potential enzyme recognition sites, Scaffold PTM scans the dataset in an experiment for overrepresented patterns in the amino acids surrounding modification sites. The motif analysis algorithm used is based on the motif discovery and scoring algorithm implemented by Schwartz and Gygi4, where protein sequences around identified PTM sites (the “foreground” dataset) are compared to protein sequences around possible PTM sites (the “background” dataset).

The prevalence of amino acids at each position in the potential motif sequences in the foreground and background datasets are used to compute a binomial probability that the experimental prevalences would be observed if PTMs were randomly distributed among potential sites (that is, independently of the surrounding sequence). These probabilities are used, when discovering new motifs or analyzing known motifs, to compute a score for each motif, using the equation

\[ S = \sum_{i} -\log(p_i) \]

where \( p_i \) is the binomial probability computed for the \( i_{th} \) position in the motif.

Motif Discovery

Scaffold PTM searches for motifs in the current dataset using the approach described in section Motif analysis algorithm. For each modification type (where the type is based on both the modification and the modified residue, so Phospho of S is considered separately from Phospho of T), this technique looks for the most significant (lowest binomial probability) combination of amino acid and sequence position and adds it to the currently considered motif. This process is repeated until no more residue/position pairs have a binomial probability greater than or equal to \( 10^{-6} \). The just-discovered motif is removed from both the foreground and background datasets to ensure that subsequent motif discovery is not biased by previously-discovered patterns in the data. The program then tries to discover

another motif by the same process. The process is repeated until no new motifs are discovered.

Motif search is activated when initially loading data or when the User clicks on the action icon Search for Motifs 🕵️‍♂️, see “Motif Tool bar” on page 105
Quantitative Statistics

Scaffold PTM can use quantitative values exported from Scaffold Q+ or Q+S to perform relative quantitation among samples or categories. The program performs statistical testing to assess the significance of fold change values calculated for each modification site. When available, these values are displayed in the PTM Quantitation Tab, and the Volcano Plot.

Statistical Analysis

For any modification site with two or more ratios within a single MS Sample (or Biological Sample or Category, depending on the current Summary Level), Scaffold PTM computes a p-value to assess the probability of observing a median fold change at least as extreme as the observed value if the true fold change were zero. That is, lower p-values imply more confidence in the conclusion that a given site was up- or down-regulated in a given sample, while high p-values imply there is not enough evidence to conclude that the true fold change was non-zero.

Scaffold PTM does not perform statistical analysis of fold changes in the Reference category, as the definition of zero fold change is drawn from these measurements.

To compute the p-value the application uses a non-parametric technique called the Mann-Whitney U Test, which is similar to a t-test, but does not assume that observations are normally distributed. Thus it is appropriate to apply to (and continues to produce meaningful p-values for) any input, e.g. when combining dissimilar samples at higher Summary Levels.

The computed p-values are visible in the PTM Quantitation tab, where each non-Reference Category sample has a second column showing the p-value for each site in that sample. These values are colored blue when they are greater than 0.05, and gold when they are less than or equal to 0.05 (i.e. significant at 0.05). The p-values are also used in the Volcano Plot, where there are transformed (via the function $y=-\log_{10}(p)$ ) to make significant values large, and insignificant values close to zero. The plot also shows a horizontal line corresponding to p=0.05, so that all sites appearing above the line are colored gold in the table.
Chapter 2
PTM Analysis in Scaffold PTM

Quantitating PTM dynamics

There are two major classes of phosphoproteomics experiments: the first is an in vitro kinase assay, where the researcher takes a group of proteins or digested peptides, adds a particular kinase and observes which proteins or peptides it phosphorylates. Since the interest is in dynamics, the researcher usually samples at time points on the order of minutes, and consequently expects that the levels of underlying proteins will not change dramatically. This is the sort of quantitative experiment for which Scaffold PTM was originally designed.

However, sometimes the primary interest is in interactions of kinases in vivo or in dynamic systems in which protein levels are expected to change. In this case, the phosphopeptide abundances reflect both changes in the phosphorylation status and in protein expression levels simultaneously. In such experiments, separating these changes becomes important in order to be able to assess the true change in PTM expression.

If the protein level does not change, then increases in phosphopeptide abundance reflect an increase in phosphorylation, while decreases in phosphopeptide abundance indicate that phosphorylation has decreased. However, if the protein expression level has changed, changes in the abundance of phosphopeptides may not reflect changes in the level of phosphorylation but may merely reflect changes in overall peptide abundance.

An important strategy for dealing with this issue was discussed in an MCP paper by the Gygi lab. In this approach, samples are labeled, combined together, and then divided into two groups. One group is carried forward for protein analysis, and the other for phospho-enrichment using IMAC, SCX fractionation, or titanium dioxide, see Figure. This results in two sets of quantitative data: those reflecting differences in the phosphopeptides, and those which can be used in assessing the overall protein levels.

PTM dynamic experiment

5. Wu R1, Dephoure N, Haas W, Huttlin EL, Zhai B, Sowa ME, Gygi SP. Correct interpretation of comprehensive phosphorylation dynamics requires normalization by protein expression changes, 2011 Molecular & Cellular Proteomics, 10, M111.009654
To accommodate this type of experiment, a new export, the Protein Quantitation XML Report, has been added to Scaffold Q+ and Scaffold Q+S. If this export is loaded into Scaffold PTM along with the ScaffoldQuantML Report, Scaffold PTM will normalize the levels measured in the PTM-enriched samples to adjust for differences in protein expression. For more details about the calculations performed see “PTM Dynamic Quantitative Calculations” on page 139.
Scaffold PTM Views

Scaffold PTM offers both a high-level overview of the list of Post Translational Modifications, or PTMs, and a detailed look at the supporting data. Scaffold PTM presents the more detailed levels in a coherent structure, helping the user to verify critical findings. The information is organized through a series of views which can be easily accessed through the main Scaffold PTM window.

Organize View

This view shows the list of MS samples loaded in Scaffold PTM. Tools included in the view help the user add new files or pare the list of files already loaded.

Figure 2-10: Scaffold PTM: Organize View

PTM List View

This View provides a list of identified proteins with the number of modification sites present in each of them.

Figure 2-11: Scaffold PTM: PTM List View
Proteins View

This view structures, in different graphical containers, a large amount of detailed information about the modifications and peptides present in a protein.

*Figure 2-12: Scaffold PTM: Proteins View*

Motifs View

This view provides the list of identified PTM motifs with its related sequence logo representation.

*Figure 2-13: Scaffold PTM: Motifs view*

Quantify View

This view consists of a series of tabs, each of which provides quantitative information about post-translational modification. Depending on the quantitative data loaded, it can show
quantitative values based on spectral counting, isobaric labeling or precursor ion quantitation. In certain types of experiments, it may show quantitative values normalized to adjust for differences in protein level, providing a better measure of differential modification.

Figure 2-14: Scaffold PTM: Quantify View

Publish View

This view contains two tabs: the Experiment Methods tab and the SQL Report tab. The Experiment Methods tab records the information needed to reproduce the analysis of the experiment. This provides the information needed for publication of results.

The SQL Report tab is an SQLite platform through which the user may view the data stored in the current SPTM file through SQL queries. Queries can be saved and reused to create custom reports.
Figure 2-15: Scaffold PTM: Publish View
Chapter 3
Loading data in Scaffold PTM

This chapter lists the types of files compatible with the application and gives a description of the loading procedure.

• “Loading data in Scaffold PTM” on page 38
Chapter 3
Loading data in Scaffold PTM

Loading data in Scaffold PTM

Scaffold PTM processes mzIdentML (MZID) and Scaffold QuantML (SQML) files. This chapter briefly describes the MZID format, lists the search engines which produce mzIdentML files supported by Scaffold PTM, explains how to load MZID files into the application and describes the type of files produced when saving a Scaffold PTM experiment.

• “Files supported by Scaffold PTM” on page 39.
• “Loading data into Scaffold PTM” on page 43.
• “Creating a Protein-Normalized Quantitative PTM Experiment” on page 46.
• “Scaffold PTM files” on page 48.
Files supported by Scaffold PTM

Scaffold PTM analyzes search engine results exported in the mzIdentML format from Scaffold, Scaffold Q+, Scaffold Q+S, Mascot, and Peaks. It also analyzes quantitative data when exported from Scaffold Q+ and Scaffold Q+S from the Q+ module.

- mzIdentML specifications
- mzIdentML exports from Scaffold
- mzIdentML exports from MASCOT
- mzIdentML exports from PEAKS
- ScaffoldQuantML exports

Figure 3-1 displays the possible paths of data from the LC-MS System to Scaffold PTM.

NOTE: Scaffold PTM does not support combining mzIdentML files produced by different programs. Results from different search engines may be processed through Scaffold and the resulting.mzid files may be loaded together into Scaffold PTM.

Figure 3-1: Data from LC-MSMS to Scaffold PTM

mzIdentML specifications

The mzIdentML standard format for proteomics data, developed by the HUPO Proteomics Standards Initiatives is a common output file format for many search engine applications. Typically mzIdentML exports create MZID files with one or more related MGF files.

- A description of the standard specifications is available at the following website: http://www.psidev.info/mzidentml.
- A Java desktop program for validating mzIdentML can be downloaded at https://github.com/HUPO-PSI/mzIdentML/tree/master/validator.

Scaffold PTM version 3 creates experiments by loading *.mzid or *.mzid.gz files version
Chapter 3
Loading data in Scaffold PTM

1.1.0 and higher. It is important that the related *.mgf files are included in the same directory where the mzid files are stored.

Note that for PTM validation, Scaffold PTM needs to have the related *.mgf files loaded along with the *.mzid files.

mzIdentML exports from Scaffold

For data analyzed in Scaffold, Scaffold Q+ and Q+S an mzIdentML export is available through the Export > mzIdentML... option in the main menu of the application. Three export types are offered in the export dialog, and the user should select “Scaffold PTM analysis”. This will generally provide mzIdentML files suitable for loading into Scaffold PTM, but by clicking Advanced it is possible to further customize the export parameters if necessary.

Once the desired options are selected, clicking OK brings up a file browser for selecting a destination into which the *.mzid file will be saved. Scaffold creates a new directory that contains *.mzid files and the related *.mgf files.

ScaffoldBatch also includes commands to create mzIdentML exports from existing Scaffold files or from new files directly created in ScaffoldBatch, for more information check the following document:


mzIdentML exports from MASCOT

Mascot creates mzIdentML files through the MASCOT Search Results page. Among the various options available in the Export Search Results pane, either “Group Proteins Families” or “Require Bold Red” should be selected. Users should also ensure that proper homology information is reported by selecting “Include Same-set protein hits”, see Figure 3-2 and should select the option “Protein sequence” from the Optional Protein Hit Information, so the created *.mzid files will include information that will allow Scaffold PTM to display sequences and coverage.
A separate export is required to produce the related MGF files, see picture Figure 3-3

**Figure 3-3: Mascot Server Export Search Results: MGF Peak List**

NOTE: When loading Mascot data, if Scaffold PTM does not find the related MGF files in the same directory where the MZID is saved, it will ask for the location of the MGF files. This might also happen if the MGF files are saved under a different name than the one reported in the MZID file. During loading, a browser will open and the user may select the MGF file which corresponds to the MZID being loaded.
Chapter 3
Loading data in Scaffold PTM

mzIdentML exports from PEAKS

Scaffold PTM loads and analyzes MZID files created by PEAKS. A description of how to export MZID and MGF files from PEAKS is provided on page 15 of the white paper Loading search engine results into Scaffold available for download on Proteome Software website.

ScaffoldQuantML exports

Scaffold Q+ and Scaffold Q+S are Proteome Software's advanced quantitative software packages. Scaffold Q+ loads iTRAQ (Applied Biosystems) and Tandem Mass Tagged (TMT, Thermo Scientific) labeled data as well as label-free precursor intensity data, while Scaffold Q+S can also load stable isotope labeled samples.

Scaffold PTM can import quantitative ratios computed by Scaffold Q+ or Q+S and compute fold change ratios for individual PTM sites. From the Q+ module, the user may select the command Export > ScaffoldQuantML. This creates one SQML file as well as its related MZID and MGF files. When the SQML file is selected for loading into Scaffold PTM, the program automatically loads the corresponding data from the related files.

Scaffold Protein Quantitation XML exports

For a specific type of quantitative experiment (see Creating a Protein-Normalized Quantitative PTM Experiment), in addition to the SQML file, Scaffold PTM also requires that the user exports a Protein Quantitation XML file. To create this export, the user should select the command Export > Protein Quantitation XML Report from the Scaffold Q+ or Q+S quantitative module. This export creates a *.ProteinQuant.XML file, which may be used by Scaffold PTM to adjust quantitative differences to account for underlying differences in protein levels in the various samples, providing a clearer analysis of differential modification levels.
Loading data into Scaffold PTM

1. To create a new experiment in Scaffold PTM, the user may either select **File > New** or click on the “New” icon located in the tool bar below the main menu in the Scaffold PTM main window. A dialog box appears asking the user to navigate to the directory where the MZID or SQML file(s) is (are) located.

*Figure 3-4: Select data files dialog box*

2. It is possible to select either a directory that contains the MZID files or a compressed directory MZID.GZ or a single MZID file. When SQML data files have been exported from Scaffold Q+ or Scaffold Q+S to analyze quantitative data the user must select the SQML file(s). The associated MZID and MGF files will be loaded automatically.

3. Clicking Open causes a new dialog, **Queue Data Files...** to appear. From this dialog, other files may be selected for loading by clicking the **Add More Files** button. All of the selected file names appear, listed in the dialog box and ready to be loaded into Scaffold PTM.

*NOTE:* It is not possible to delete a specific file from the Queue Data Files list. Once the files are loaded the user can delete a file from the loaded files list by clicking the delete button in the Loaded Files Pane in the Organize View.
4. When analyzing modifications which readily undergo neutral losses that complicate the localization calculations, the user may wish to open the Advanced tab and select the option “Use Neutral Loss Model for Ascore”.

5. Clicking Load starts the loading operation of the listed files into Scaffold PTM.
   - Depending on the size of the files included in the loading list, the loading operation will require some time. A wait dialog box provides a description of the ongoing operations during the loading phase and a general estimate of the time left to completion.
   - When the loading operation is completed, Scaffold PTM opens the Organize view which shows the list of loaded files.
Chapter 3
Loading data in Scaffold PTM

Figure 3-6: Data loading operation
Chapter 3
Loading data in Scaffold PTM

Creating a Protein-Normalized Quantitative PTM Experiment

For certain types of quantitative studies, Scaffold PTM includes a feature that enables quantitative analysis of PTM activity by simultaneously considering protein-level and site-level changes within an experimental condition, see “Quantitating PTM dynamics” on page 30.

To create a protein-normalized PTM Quant experiment in Scaffold PTM, the user must:

1. Create two Scaffold Q+ or Scaffold Q+S experiments, one with modification-enriched Quant data and one with protein Quant data (see an example of the experimental workflow in the section Quantitating PTM dynamics).
2. Export a SQML file for the modification-enriched experiment using the command Export > ScaffoldQuantML report... located in the Q+ quantitative module menu.
3. Export a Protein Quantitation XML file for the unenriched protein experiment using the command Export > Protein Quantitation XML report... located in the Q+ quantitative module menu.

4. Load the SQML data file into Scaffold PTM, as instructed in Loading data into Scaffold PTM and save the file.

The PTM Quantitation Tab and Volcano Plot will show the loaded quantitative ratios for each PTM site in the experiment. Because the protein quantitation data has not yet been loaded, the PTM Quantitation Tab will have the title “PTM Quantitation”, and the Volcano Plot will show all points as triangles.

5. To normalize the data by protein quantitative expression change, the user must load protein quantitation data into the Scaffold PTM experiment just created. This can be done by selecting the command Experiment > Import Protein Quantitation Results... from the Scaffold PTM main menu and choosing the XML file exported in Step 3.

6. After selection of the XML file, a hierarchical list of the samples and quantitative channels in the imported file appears.
7. Match the samples in the PTM experiment with their corresponding protein measurements.

*Figure 3-9: Organizing protein quantitation samples*

8. After specifying the sample organization, click “OK” and the data will be imported.

The PTM Quantitation Tab will now display the title “PTM Quantitation (Protein-Normalized)” and the values shown will be normalized by the imported protein ratios. In any sample for which a protein’s ratio was not measured, the values shown will be un-normalized and surrounded with square brackets (“[<ratio>]”). The Volcano Plot will show all sites with protein-normalized ratios as circles, and, by default, will not show any un-normalized data.
Scaffold PTM files

Scaffold PTM creates its own file type called SPTM, which stands for Scaffold Post Translational Modification. This file is an SQLite file, a lightweight, high performance SQL database file with a great deal of flexibility. Indeed, in Scaffold PTM, it is possible to query the experiment using Structured Query Language (SQL) and also to save these queries for future use. This direct access to the data structure gives Scaffold PTM users a unique capability to manipulate and analyze their data.

Inconsistent Ascore Warning

This message appears if a file created in a previous version is opened and the program detects that the displayed Ascore values, which are the values saved in the file, do not match the calculations depicted in the Spectrum &Ascore display, which is recomputed when the file is opened.

This is an unexpected situation, so if you encounter this warning, please contact support@proteomesoftware.com
Chapter 4
Scaffold PTM Main Window

Scaffold PTM, like all of the applications in the Scaffold Suite, is built around a main window which contains a number of different views. In each view the experimental data is organized so that users can easily examine experimental results from different perspectives.

This chapter provides a detailed description of the various tools in Scaffold PTM’s main window, which are always available from any of the views.

• “The Scaffold PTM Window” on page 50
The Scaffold PTM Window

The Scaffold PTM main window provides quick access to all of the features and functions of the application.

The window has ten major components:

- Title bar
- Main menu commands
- Tool-bar
- Summarization bar
- Scaffold PTM Main Window Filters bar
- Navigation bar
- Display pane.

Figure 4-1: Scaffold PTM main window
Chapter 4
Scaffold PTM Main Window

Title bar

Figure 4-2: Title bar

The Scaffold PTM logo and the program name are always displayed in the title bar at the top of the main window. If an experiment is open, the experiment name also appears in the title bar. When a new experiment is created, the default name “PTM Experiment” is displayed, and when an experiment is saved, the name of the SFDB file becomes the new experiment name.

The version of Scaffold PTM in use is not displayed in the Title bar. The user must select the Help > About option in the main menu to determine the version number. See “Main menu commands” below.
The Scaffold PTM main menu consists of sub menu commands (File, Edit, View, Experiment, Export and Help) across the menu bar. Some of these menu commands are also available in other areas of the application.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Commands</th>
</tr>
</thead>
</table>
| **File** | • **New (Ctrl+N)**—Starts a new experiment and opens a file browser to allow the selection of *.mzid files to be loaded in the application. Once files are selected, the Queue Data Files dialog opens, allowing the user to add more files to the queue for loading. See "Loading data in Scaffold PTM" on page 38.  
• **Open (Ctrl+O)**—Opens a saved Scaffold PTM experiment file, *.sptm, through a file browser.  
• **Close**—Closes the current experiment.  
• **Save (Ctrl+S)**—Saves the current experiment.  
• **Save As**...—Saves the current experiment offering the option to use a different name.  
• **Print... (Ctrl+P)**—Prints the current view.  
• **Print Preview**...—Previews the current view with the option of printing the document.  
• **Exit**—Closes the Scaffold PTM window. |
| **Edit** | • **Undo** - when active, allows the last operation to be reversed.  
• **Redo** - when active, allows reapplication of an operation that has been reversed using Undo.  
• **Copy (Ctrl+C)**—Copies the currently selected table to the clipboard. The user can then paste the copied information into a third-party program such as Excel or Microsoft Word.  
• **Find (Ctrl+F)**—Opens the Find dialog to search the currently selected table in the Current View.  
• **Edit GO Terms Option**...—See "Edit GO Term Options" on page 57.  
• **Preferences**—see “Preferences” on page 54 |
### Chapter 4

**Scaffold PTM Main Window**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Commands</th>
</tr>
</thead>
</table>
| **View** | • **Navigate**— Allows movement between tabs in the current view:  
  - Select Previous Tab (CTR+Page Up)—  
  - Select Next Tab (CTR+Page Down)—  
  - Organize View (CTRL+1)— see “The Organize View” on page 76  
  - PTM List View (CTRL+2)— see “The PTM List View” on page 82  
  - Proteins View (CTRL+3)— see “The Proteins View” on page 92  
  - Motifs View (CTRL+4)— see “The Motifs View” on page 104  
  - Quantify View (CTRL+5)— see “The Quantify View” on page 114  
  - Publish View (CTRL+6)— see “The Publish View” on page 124 |
| **Experiment** | • Add and Analyze mzIdentML...(CTRL+A)— Opens a file browser to select MZID data files to add to the experiment, see “Loading data in Scaffold PTM” on page 38.  
  • Import Protein Quantitation Results...— Active only when the current experiment contains labeled or precursor intensity quantitative data. Opens a file browser for importing Protein Quant XML files exported from the Scaffold Q+/Q+S module, see “Creating a Protein-Normalized Quantitative PTM Experiment” on page 46.  
  • Use Protein Grouping— Toggles the display of the proteins in the PTM List View. When this option is selected, proteins which share peptides are grouped.  
  • Apply GO Terms— Active when at least one GO annotation database has been loaded into Scaffold PTM. When this option is selected, Scaffold PTM searches the selected GO database for annotations matching proteins in the PTM List and displays them in the table, see “Edit GO Term Options” on page 57. |
| **Export** | All exports included in this menu create a Coma Separated Values (CSV) text file that can be opened and viewed in Excel.  
  • Export Current View report to Excel...—Generates a CSV file of the current view as it appears.  
  • Export PTM List Report to Excel...—Generates a CSV file of the PTM List table as it appears in the PTM List View.  
  • Export Spectrum Report to Excel...—Generates a CSV file with the list of all spectra in the experiment, see “Spectrum report” on page 131.  
  • Export Filtered Spectrum Report to Excel...—Generates a CSV file with the list of spectra in the experiment which respects the current filter settings, see “Spectrum report” on page 131.  
  • Export Motifs Report to Excel...—Generates a CSV file of the information listed in the Motifs table.  
  • Export PTM Counts Report to Excel...—Generates a CSV file of the PTM Spectrum Counts table for all proteins.  
  • Run SQL Query for Export...—Opens the SQL Report tab of the Publish View, see “SQL Export tab” on page 126. |
Find Dialog

The **Find dialog** searches and highlights proteins in the PTM List table. The filter searches for the typed characters in the Protein Name and Accession Number columns in the PTM List Table. Only proteins containing matching strings are displayed. If the searched items are found the text box turns green, if not it turns red.

Preferences

The main menu option: **Edit > Preferences**, opens the **Preferences** dialog which contains the following tabs:

- “Colors tab” on page 54
- “Motif Background tab” on page 55
- “System” on page 56
- “User Interface” on page 57

Colors tab

This tab allows the user to customize the colors assigned to each PTM, see Figure 4-4.
Double-clicking on the colored box assigned to a PTM in the Colors tab opens the color selection dialog. Through this dialog, a different color may be assigned to the selected PTM using swatches, or the HBS or RGB methods, see Figure 4-5.

**Figure 4-5: Color Selection Dialog**

The **OK** command finalizes the new color selection, while **Reset** restores the original choice and **Cancel** voids the operation.

**Motif Background tab**

Scaffold PTM’s motif analysis identifies sequence patterns that are over-represented in the amino acids surrounding modification sites. In order to assess this, the program uses a set of proteins as a background and measures the frequency with which a specific amino acid is surrounded by a particular sequence motif to establish a Background Percentage for comparison.
When using "FASTA Database" or "Identified Proteins" as the Background source, Scaffold PTM will consider ALL sequences in the protein surrounding the given residue, as it has no information about which of these are truly PTM sites. This is typically the desired behavior when doing motif discovery, as the motifs then represent the sequences that are "responsible" for some sites being modified.

The Motif Background tab allows the user to define the set of proteins from which the application will calculate the Background Percentages. The following choices are offered:

- **Use Identified Proteins Only** - Scaffold PTM calculates Background Percentages based on only the proteins present in the experiment.
- **Use Fasta Database** (More robust) - Scaffold PTM calculates the Background Percentages based on a FASTA database specified by the user.

**Figure 4-6: Motif Background Tab**

### System

This tab allows the user to adjust a number of system-related settings:

**Memory Usage**

This control sets the maximum amount of memory that the system may allocate to Scaffold PTM. It is recommended that the memory allocation be set to a little less than the physical RAM available on the system. The first field accepts a number while the second provides a drop-down menu from which the user may select the units.

- The new memory setting will take effect only after the application has been closed and restarted.
Number of Processors

This control allows the user to choose the maximum number of processors to be assigned to Scaffold PTM for computations. The default value is the maximum number of processors present in the system where the application is installed.

Internet Settings

This tab allows the user to enter a proxy server name or an IP address and a proxy port number if needed. Through the check boxes in this dialog, the user may:

- **Allow Scaffold PTM to connect to the Internet** If this box is unchecked, then Scaffold PTM cannot access the Internet. A user might want to uncheck this box if organizational rules prohibit connection to the Internet.

- **Use HTTP Proxy Server**
  - **Proxy Server name (or IP address)**
  - **Proxy port number**

  Proxy servers may be used by an organization's IT department to filter communications to and from the Internet. If this is the case, the user needs to set the Proxy Server Name and Port Number. To determine whether proxy server settings are needed, a user may examine the way his or her web browser is connected to the internet.

User Interface

This tab contains settings that control the behavior of the user interface.

Messages

Some messages displayed by Scaffold PTM contain a checkbox that says “Do not show this message again.” When this has been checked, the program disables the message dialog. This control allows the user to resume display of these messages.

Views

This control allows the user to choose which View will open automatically when new data is loaded into Scaffold PTM.

Edit GO Term Options

Selecting **Edit > Edit GO Term Options** from the main menu, opens the GO Term Configuration dialog. The dialog contains the following tabs:

- **The Displayed GO Terms Tab**
- **GO Annotations Tab**

The Displayed GO Terms Tab
This tab allows the user to create and maintain a custom list of GO terms. This list determines which GO terms will be displayed as extra columns in the PTM List table when GO annotations are applied to the proteins in the experiment.

The **Display GO Terms** tab is divided into the following sections:

- **Search Field** - Searches GO terms available in the gene_ontology.obo file found in the parameters folder of the Scaffold PTM installation directory.
- **GO Tree list** - Hierarchical list of all available GO terms.
- **Add and Remove GO terms** - Provides tools for creating the custom Display List.
- **Display List** - List of GO terms selected by the user that will be visible in PTM List table.
- **Save and Apply** - Allows the user to save the current Display List if changed.

The user can create a new custom GO terms Display List by following these instructions:

1. If the **Display List** is not empty, select all rows and press delete.
2. Search and select any GO term of interest either by typing a name in the **Search Field** or by selecting a row in the **GO Tree List**.
3. Click **Add**; the selected term or group of terms is added to the **Display List**. Terms may be selected individually or by domain or group. If a group or domain is selected, all terms in that group will be added to the **Display List**.

4. To remove terms from the **Display List**, select a term or group of terms to be discarded then click **Remove**.

5. To save the current selections as **User Defaults** check the box **Save displayed GO terms as user default**.

When a Scaffold PTM experiment is saved, the displayed GO terms are saved with the SPTM file.

When a new file is created, or when Scaffold PTM is closed, the list of displayed GO terms is retained. To reset the list to the defaults, the user may click the **Reset to User Default** or the **Reset to Scaffold Default** button.

**GO Annotations Tab**

Scaffold PTM builds a table containing all GO annotations imported into the program from GO annotation database files. When GO annotations are applied to an experiment, the entire Scaffold PTM GO annotation table is searched for GO terms matching the proteins identified in the experiment.

The GO Annotations Tab contains a table listing the GO annotation databases already imported into Scaffold PTM. When no GO annotations have been imported and no GO database is available, a warning appears and the menu command **Experiment>Apply GO Terms** does not function. The user may populate the table with existing or custom-created GO term databases through the **Import Annotations** function.

The GO Annotations Tab also includes a search box that searches the list of imported GO databases.
Chapter 4
Scaffold PTM Main Window

Figure 4-8: Go annotations tab

Import Annotations

The **Import Annotations** button opens a dialog through which the user may import GO Annotation databases. A pull-down menu directs Scaffold PTM to different locations from which GO Annotation Databases may be downloaded.
Figure 4-9: Add GO Annotations Database dialog

The pull down list includes the following items:

- **Human Only** - provides a download of the human subset. It takes about 10 minutes to download.
- **Other Website** - the user can type in a website address from where a GO Annotations Database can be downloaded.
- **Other File** - the user can direct Scaffold PTM to a location in his/her computer where the GO Annotations database is stored.
- **Individual Taxonomy GOA Files** from /ftp.geneontology.org/pub/go/gene-associations/

Selecting one of these options and clicking **Add** imports the selected GO Annotation database into Scaffold PTM and adds its name to the list of loaded databases.

Because the full download of the Gene Ontology Database for all proteomes has grown so large, it is no longer included in the drop down list. Before loading the full database into Scaffold PTM, please check that the system’s temp directory contains sufficient free space and note that the process may take many hours.

Clicking **OK** closes the dialog. The user may then annotate the protein list in the PTM List table with GO terms by choosing the now available option **Experiment > Apply GO Terms**.

The command **Experiment > Apply GO Terms** is available for use only when one or more GO Annotations databases are loaded into Scaffold PTM.
The Scaffold PTM’s tool bar contains icons that represent equivalent commands for frequently used main menu options.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td><strong>New</strong>—Starts a new experiment by opening a file browser to locate MZID data file to be loaded in Scaffold PTM. See “Loading data into Scaffold PTM” on page 43</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td><strong>Open</strong>—Opens a saved Scaffold PTM experiment file, *.sptm, through a file browser.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td><strong>Save</strong>—Standard Windows behavior.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td><strong>Print</strong>—Prints the current view.</td>
</tr>
<tr>
<td><img src="image" alt="Print Preview" /></td>
<td><strong>Print Preview</strong>—Previews current view with the option of printing the document.</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td><strong>Undo</strong>—</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td><strong>Redo</strong>—</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td><strong>Copy</strong>—For each view copies the selected table to the clipboard. The user can then paste it into a third-party program such as Excel or Microsoft Word.</td>
</tr>
<tr>
<td><img src="image" alt="Find" /></td>
<td><strong>Find</strong>—Opens a find dialog box that searches the currently selected table, see “Find Dialog” on page 54.</td>
</tr>
<tr>
<td><img src="image" alt="Excel" /></td>
<td><strong>Excel</strong>—Exports the information that is contained in the current view to a CSV text file which can be opened and viewed in Excel.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td><strong>Help</strong>—Opens the Scaffold PTM Online Help.</td>
</tr>
</tbody>
</table>
Summarization bar

The summarization bar provides an easy way to switch between different levels of summarization of the MS samples loaded in the experiment. Data will be collapsed or expanded to the selected hierarchical level. The Summarization bar operates through a drop down menu containing a list of Attribute groups hierarchically ordered. While the Summarization bar is accessible throughout the program, it operates only on the values in the Quantify View.

*Figure 4-11: Scaffold PTM Summarization bar*
Scaffold PTM Main Window Filters bar

The Scaffold PTM Filters bar is located under the main menu bar at the right side of the Summarization bar. It contains two filters.

*Figure 4-12: Scaffold PTM Filters bar*

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Min Localization Icon" /></td>
<td><strong>Min Localization</strong>—Filters PTM sites according to their Localization Probability.</td>
</tr>
<tr>
<td><img src="image" alt="Visible Modifications Icon" /></td>
<td><strong>Visible Modifications</strong>—Toggles visibility of modifications in the Samples View.</td>
</tr>
</tbody>
</table>

Note that spectra whose modification sites do not meet the Min Localization threshold or whose modification types are not marked as Visible are still displayed in the PTM Modification Sites table in the Proteins View.

Modification Sites that do not have at least one spectrum which meets the Min Localization threshold or whose modification types are not marked Visible are removed from the Protein Sequence, however. Counts in the PTM List table are also adjusted based on these criteria.
Navigation bar

Figure 4-13: Scaffold PTM Navigation bar for View selection

The Scaffold PTM Navigation bar is a vertical bar displayed on the left side of the Scaffold PTM main window.

The bar contains buttons that toggle the six available views in the Scaffold PTM main window:

- The Organize View, see “The Organize View” on page 76.
- The PTM List View, see “The PTM List View” on page 82.
- The Proteins View, see “The Proteins View” on page 92.
- The Motifs View, see “The Motifs View” on page 104.
- The Quantify View, see “The Quantify View” on page 114.
- The Publish View, see “The Publish View” on page 124.
Chapter 4
Scaffold PTM Main Window

Display pane

Scaffold PTM’s Display pane shows the View selected in the Navigation bar. Each View consists of one or more tables or graphs in one or more sub-panes. All panes and tables in Scaffold PTM’s Display pane share certain characteristics:

- **Table Features**
- **Graph Features**
- **Pane Features**
- **Mouse Right Click Context Menus**

Table Features

All tables in Scaffold PTM include the following tools:

- **Tool Tips**
- **Resizing of columns and panes**
- **Column Control**
- **Moving columns**
- **Column sorting feature**
- **Multi selection of rows**

Tool Tips

The user may view information about fields or columns in a View by hovering over the location of interest with the mouse pointer. Pressing F2 opens expands the displayed tool-tip and allows the user to copy the information contained in it. Pressing the Escape (ESC) key on the keyboard closes the expanded tool-tip.

*Figure 4-14: Viewing information in a tool-tip*
Resizing of columns and panes

The user may resize columns and panes in each of the views to better suit his/her needs. For example, in the Samples View, the width of a column may be changed by resting the mouse pointer on the right side of a column header until the pointer changes to a double-headed arrow, and then dragging the boundary until the column is the desired width.

Column Control

All tables throughout Scaffold PTM have a feature called Column Control. It is a vertical button located to the right of the column headers. When the user clicks this button, a drop down menu containing a list of all columns in the table opens. Each column name has a check box and at the bottom of the list are three group commands.
Unchecking columns from the list will hide them in the table. Note that columns can also be hidden by right clicking over the heading of a column and selecting the “Hide Column” option that appears. Columns must be hidden one by one.

The Horizontal Scroll command, if checked, will add a scroll bar at the bottom of the table. Pack all columns, when selected, resizes each column to the width of the longest value in the column. Pack selected column is active when a specific column has been selected in the table before opening the Column Control.

Moving columns

In all tables throughout Scaffold PTM, each column can be moved from one position to another as desired.

To move a column, click on the header of the column and drag it to the new location. The new column order will be maintained while switching views.
Column sorting feature

In all tables throughout Scaffold PTM, clicking on any column header activates a tri-state sorting function. For example, to sort the proteins based on increasing molecular weight, click the Molecular Weight column header once. To sort the proteins based on decreasing molecular weight, click the Molecular Weight column header twice. To return to the default display, click the Molecular Weight column header a third time.

Multi selection of rows

In all tables throughout Scaffold PTM, the user can select multiple rows by using either the SHIFT or the CTRL key, depending on whether or not the rows in the desired selection are contiguous, and a mouse-click. Other functions may then be applied to all selected rows simultaneously.

Graph Features

Every graph appearing in any of Scaffold PTM’s views shares the following tools:

- **Zoom Function** - Holding down the left mouse button and dragging the pointer from left to right zooms in on a graph. In some graphs, a two-dimensional area may be enlarged by...
Chapter 4  
Scaffold PTM Main Window

holding down the left mouse button and dragging to the right and down. Clicking anywhere in the graph returns the graph to the previous magnification level.

• **Context menu** - The user can right-click on a graph to open a context menu. The specific context menu depends on the view where the graph appears, see “Mouse Right Click Context Menus” on page 70 and “Context Menus - Right Click Commands” on page 140 for more information.

Pane Features

A view may contain one or more panes. The individual panes can be expanded or contracted by clicking and holding the mouse over their top or side edges until a double head arrow appears and then sliding the mouse either up and down or right and left, see Figure 4-21.

![Figure 4-21: Panes size adjustments](image)

Mouse Right Click Context Menus

When the user right clicks the mouse while hovering over the Display Pane, a context menu with various options appears near the mouse pointer. The list of options available in the context menu varies depending on the selected View. A description of the context menu commands is provided in “Context Menus - Right Click Commands” on page 140.

**View**

This view has two slightly different context menus depending on the pane. **Context Menu A** appears when the user right clicks in the **Loaded Files pane**.

**Context Menu A:**
When right clicking over the MS Sample Data pane, Context Menu B becomes available. This menu includes an extra command that allows the deselection of the “Used” check box in all highlighted rows.

**Context Menu B:**

<table>
<thead>
<tr>
<th>MS Sample Data</th>
<th>Biological Sample</th>
<th>Biological Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used</td>
<td>PTM Sample</td>
<td>Category_1</td>
</tr>
<tr>
<td>000021 Fly Embryo Sa 2006</td>
<td>A_1</td>
<td></td>
</tr>
<tr>
<td>000022 Fly Embryo Sa 2005</td>
<td>A_2</td>
<td></td>
</tr>
<tr>
<td>000023 Fly Embryo Sa 2009</td>
<td>A_3</td>
<td></td>
</tr>
<tr>
<td>000024 Fly Embryo Sa 2007</td>
<td>A_4</td>
<td></td>
</tr>
<tr>
<td>000026 Fly Embryo Sa 2005</td>
<td>B_1</td>
<td></td>
</tr>
<tr>
<td>000027 Fly Embryo Sa 2008</td>
<td>B_2</td>
<td></td>
</tr>
</tbody>
</table>

**PTM List View**

When the user right clicks anywhere over the Mod List table, a menu appears. The menu contains a number of different sub-menu options:

**Context Menu C:**

**Proteins View**

When the mouse hovers over the different panes in this view, a right click opens similar context menus, but with slight differences.

- **Sequence Coverage Pane** > Sequence tab -- Available context menu: Context Menu D

**Context Menu D:**
Chapter 4  
Scaffold PTM Main Window

The same sub-menus are available as in Context Menu A.

- **PTM Sites Pane** -- Available context menu: Context Menu E

  ![Context Menu E](image)

  The same sub-menus are available as in Context Menu A.

- **The Ascore Algorithm Pane** - Available context menus:
  - Spectrum and Ascore tab - Context Menu B appears when right clicking on the spectrum:

    ![Context Menu F](image)

    - Spectrum and Ascore tab - Context Menu G appears when right clicking on a Bar graph:

    ![Context Menu G](image)

    The same sub-menus are available as in Context Menu A.

- **Peptide Score tab > Modification name tab** - Available context menu:
Display pane

Motifs View

When hovering over the tables included in this view, a mouse right click opens . While clicking over the Motifs representation pane appears.

Quantify View

When hovering over the tables included in this view and appearing under the PTM Spectrum tab and the PTM quantitation tab, a mouse right click opens Context Menu A. When hovering the Quantitative Charts tab, the context menu available is the following:

Publish View

When hovering over the text pane in this view, a mouse right click opens the following context menu:
Chapter 5
The Organize View

This chapter describes the features of the Organize View in Scaffold PTM.

• “The Organize View” on page 76.
Chapter 5
The Organize View

The Organize View

The Scaffold PTM Organize View appears immediately after a new analysis is created or a previously saved *.sptm is opened. It provides the ability to group the loaded MS samples into Biological samples, define fractions, and select or deselect MS samples for inclusion in the PTM analysis.

The Scaffold PTM Organize View contains:

- The **Loaded Files pane** -- which lists the loaded MZID data files
- The **MS Sample Data pane** -- which shows more detailed pieces of information about the MS data contained in every loaded file.
Loaded Files pane

The Loaded Files pane contains a list of the MZID files loaded into the application.

A tool bar at the upper right of the pane contains two operational icons: the Add and Delete icons.

Clicking Delete excludes the selected files from the list.

Clicking the Add icon opens a file browser, allowing the user to navigate to and select *.mzid or *.sqml data files for loading. Once one or more files are selected and the Open button is clicked, the Queue Data Files dialog opens. This dialog offers the option to add more files to the loading queue.

When all desired files have been selected and analyzed, the table to the right, in the MS Sample Data pane, is populated with a list of the MS samples loaded from the MZID files.
MS Sample Data pane

This pane contains a table with information about the MS files represented by the original MZID files loaded into Scaffold PTM. The program assigns the following parameters, shown in columns, to each MS sample:

- **Used** - When checked, the MS Sample is included in the analysis; otherwise it is not. The default value is checked.
- **MS Sample** - Name of the MS sample; the program assigns a default value which can be edited.
- **Biological sample** - Name of the Biological Sample, the program assigns a default value which can be edited.
- **Biological category** - Name of the Biological Category, the program assigns a default value which can be edited.
- **Fraction #** - Number of the fraction corresponding to the MS sample. The cell is editable but accepts only numeric characters.
- **File Location** - Original location of the loaded file containing the spectral data for the MS sample.
- **Notes** - This column allows the user to enter additional information. If an error occurs during the load and analyze phase, Scaffold PTM will report it in this column.

It is possible to edit all of these assignments except the file location. Double clicking in one of the writable cells activates a cursor with all of the usual character editing features.

Many MS Samples may belong to a single BioSample, and a Category may include multiple BioSamples. By modifying the names in the table, the user can recreate the organization of the proteomic experiment as it was initially envisioned.
Queue Data Files dialog

Figure 5-22: Queue Data Files dialog

When a new experiment is created, either by selecting File > New or by clicking over the icon New, a file browser opens to let the user easily locate and select the MZID files to be loaded. Once selected, the file or files appear in the Queue Data Files... dialog and are ready to be loaded. The dialog provides options for adding more files to be analyzed in Scaffold PTM.

When the Add More Files button is clicked, the file browser reappears, allowing the user to locate more files to be loaded. By selecting files and clicking open, the user adds to the existing loading queue. At this point the user can add more files, cancel the whole operation or initiate the loading procedure.

NOTE: It is not possible to delete specific files from the loading list. On the other hand, once the files are loaded, the user can select and delete one or more files from the Loaded Files: list by clicking the delete button in the Loaded Files pane.
Chapter 5
The Organize View
Chapter 6

The PTM List View

This chapter describes the PTM List View which provides tools and features to help the user arrange and summarize the experimental results in convenient ways.

- “The PTM List View” on page 82.
The PTM List View

The PTM List View of Scaffold PTM provides an overall look at the Post Translational Modifications in the proteins in the experiment.

The PTM List View includes the following tools:

- **The Mod List Table** -- A table showing, for each protein or protein group, the count selected in the **Display Options** control for each Post Translational Modification (PTM) searched in the loaded Samples. See “The Mod List Table” on page 83.

- **The Proteins list** -- A list of the identified proteins included in the loaded MZID files, see “The Proteins List” on page 85.

- **The Display Options: bar** -- A pull down list with different counting options for displaying PTM abundance, see “Display Options: bar” on page 88.

- **The Filters bar** -- Which provides tools to search and conveniently filter the protein list, see “Filters: bar” on page 89.

Figure 6-1: The Scaffold PTM’s PTM List View
The Mod List Table

The Mod List Table is a Frequency Table, which displays abundance values for every modification in each protein group.

The Display Options pull down menu located in the Display Options: bar above the Mod List Table, allows the user to select the type of count to be used to express the abundance of the modifications reported in the table.

The user can apply thresholds and filters to the Mod List Table using the tools offered in the Filters: bar located next to the Display Options: bar above the Mod List Table.

Samples Table general characteristics:
- “The Mod List Table Features” on page 83
- “Initial Thresholds” on page 84
- “Default Sorting of Columns” on page 84
- “Summary Level and the Mod List Table” on page 84
- “Probability Legend” on page 84

The Mod List Table Features

Like any table in Scaffold PTM, the Mod List Table includes the features and tools described in “Display pane” on page 66.

The first four columns, initially ordered as shown below, appear in every experiment and provide the following information:

- **Column #** -- Order number of each row when sorted in the initial order.
- **Column Star** -- Initially shows an empty star for every row. Clicking on a star changes its color, and clicking multiple times causes the star to loop through four possible states. The color goes from gray to orange, to blue, to orange and blue, then back to gray. Having multiple star states allows the user to group and filter proteins in complex ways. For more information see “Tagging Proteins of Interest: the star function” on page 86.
- **Column Protein Name** -- Protein or protein group name.
- **Column Accession** -- Protein identification number. The particular type of ID shown depends on the parsing rules applied to the protein accession numbers during the database search or Scaffold analysis.

The remaining columns are arranged into two groups:

- **Scores** -- Typically includes columns showing the main search engine scores associated with the protein or protein group. For example, when Scaffold data is loaded, columns Protein probability and Sequence Coverage columns are shown.
Chapter 6  
The PTM List View

- **Modifications** -- This group includes a columns for each variable modification included in the database search. Cells displaying abundance values are color-coded according to the modification type.

  The order of the columns can be changed, and columns may be hidden. For instructions, see “Display pane” on page 66.

Initial Thresholds

  When the PTM List view is selected for the first time after loading completes, the default threshold values applied to the Modifications are as follows:

  - Min. Localization: 95%
  - Visible Modifications: All

  For more information about these filters, see “Scaffold PTM Main Window Filters bar” on page 64.

Default Sorting of Columns

  When the PTM List View is visited for the first time, the protein list is sorted by:

  1. Decreasing protein spectrum counts.
  2. Decreasing alphabetical order of the accession number

  The tri-state sorting feature, activated by clicking on any column header, sorts the data according to the selected column. The first click sorts in ascending order, the second click in descending order, and clicking three time restores the initial order.

Summary Level and the Mod List Table

  Adjusting the Summary level does not affect the Mod List table.

Probability Legend

  This appears only when data analyzed by Scaffold and containing protein probabilities is loaded into Scaffold PTM. It is located at the top of the Mod List Table in the Protein name column header and it defines the color coding associated with the Scaffold protein probabilities.
The Proteins List

Proteins which share peptides can be displayed as groups using the command **Experiment > Use Protein Grouping.** This option toggles between grouped and individual protein modes, see “Representation of Protein groups” on page 85. The application also offers tools to filter the list of proteins.

The following information may be useful when examining the Proteins List:

- “Representation of Protein groups” on page 85
- “Proteins displayed in red” on page 86
- “Tagging Proteins of Interest: the star function” on page 86
- “Applying filters to the Proteins List” on page 87

**Representation of Protein groups**

If the grouping option is selected, see “Main menu commands” on page 52, each entry in the protein list will represent a protein group. Scaffold PTM merely displays protein grouping information read from the input files. Structures and names of protein groups are typically created by search engines or by Scaffold according to their grouping algorithms.

*Figure 6-2: Protein groups in the PTM List View*

If a group includes more than one protein, it can be expanded or collapsed for ease of inspection, thus reducing the number of independent rows in the list. When a row displays a protein group with more than one protein, a click-able icon showing either a + or a - sign, provides the ability to expand or contract the group, see *Figure 6-2.*

- The icon is a + sign when the group is collapsed. To expand the group, click the square and the sign shown will become a - sign. Clicking the minus sign will collapse the group. When the group is expanded, the list of its proteins is visible and...
Chapter 6
The PTM List View

highlighted in dark gray. Each row in the list is numbered as a subset of the protein group number. For example, see Figure 6-2, in the expanded protein group in the first row of the Mod List table, we can see five proteins, which are numbered 1.1, 1.2 and so on. The numbers appear in a hierarchical structure in the # column.

- A plus sign and a number are appended to the accession number representing the group to indicate the number of proteins in the group.

Proteins displayed in red

At times, proteins or protein groups in the Mod List table appear in a red font. This occurs in two possible circumstances:

1. The protein sequence is not available. For example, this can happen if the data was exported from a Scaffold experiment in which an incorrect FASTA database had been applied, or if an mzIdentML file is imported from another program which does not supply protein sequences.

2. Peptide sequences cannot be not localized along the protein sequence.

When this happens Scaffold PTM does not have enough information to assess the Ascores or Localization Probabilities for the modifications in the protein. Modification site counts may also be incorrect, since the program is unable to align the peptides with the sequence and identify overlapping peptides that may contain the same modification site. Highlighting the protein in the PTM List warns the user that for the highlighted protein, Scaffold PTM cannot correctly localize their modifications.

NOTE: a warning also appears in the Proteins View, see Figure 6-3: Example of proteins and protein groups highlighted in red.

Tagging Proteins of Interest: the star function

The user can mark proteins that are of special interest by simply clicking the protein star icon
shown in the **Star** column. Two different colored stars, blue and orange, and a combination of an orange and a blue star are available by clicking multiple times on the same star or by selecting the star option in the right-click menu.

By using a combination of different stars it is possible to create four different sets of proteins of interest. The user can then bring these proteins to the top of the display by clicking the **Star** column header and can return to the default protein order by clicking the column header twice more. The user can also filter based on stars using the Star filter available in the Filters bar, see “Star Filter” on page 89.

Groups of selected proteins can be starred together by using the star option in the right click menu, see Figure 6-4.

**Figure 6-4: PTM List View - Starring proteins**

Applying filters to the Proteins List

Scaffold PTM provides a Text Search box located in the Filters bar above the Mod List Table to help users reduce the size of the protein list or search for specific proteins of interest, see “Text Search box” on page 89
Chapter 6
The PTM List View

Display Options: bar

The Display Options pull down list offers a range of options for displaying PTM abundance. The values shown in the Mod List Table depend on the Display Option selected. The Display Options drop down list offers the following choices:

Figure 6-5: List of Display Options

- **Number of Modification Sites** -- Displays number of PTM sites in each protein.
- **Number of Unique Modified Peptides** -- Displays number of identified peptides in the specified protein that contain modifications.
- **Number of Assigned Spectra** -- Displays the non normalized count of spectra displaying a specific type of modification for each protein.
Chapter 6
The PTM List View

Filters: bar

The Filters: bar includes two different tools that can be used to reduce the number of proteins shown in the proteins list appearing in the Mod List Table and also to tag specific proteins of interest.

- “Star Filter” on page 89
- “Text Search box” on page 89

Figure 6-6: PTM List View: Filters: bar

Star Filter

The Star Filter box contains four toggle buttons. Each button is characterized by one of the four possible star states which the user can trigger for a specific protein or group of proteins, by clicking the icon shown under the “Star” column in the Mod List Table. This action is referred to as starring a protein.

Each star filter button has two possible filtering states:

- Unfiltered - The star appears in the icon. When a star color is unfiltered, proteins with stars of that color are displayed in the proteins list. Clicking the button changes the status to filtered.

- Filtered - The star appears with a red diagonal bar across it. When a star is filtered, proteins with stars of that color are not included in the proteins list. Clicking the star filter button again clears the filter and returns the proteins to the PTM List view.

It is possible to select one or more star filter button at the same time. The proteins tagged with the selected stars will be hidden from the proteins list. Selecting the uncolored star leaves only the starred proteins in the list. For more information on how to assign stars to proteins in the PTM List View, see Tagging Proteins of Interest: the star function.

Text Search box

The Text Search box filters the list of proteins in the Mod List Table, displaying only proteins which contain the string that has been typed in the box. The filter searches for the typed characters in the Protein Name and Accession Number columns in the Mod List Table.
Chapter 6
The PTM List View
Chapter 7
The Proteins View

The Scaffold PTM’s Proteins View provides the details of modification site localization for a specific protein.

This chapter details the various panes and tabs constituting the Proteins View.

“The Proteins View” on page 92
Scaffold PTM’s Proteins View offers various graphical tools designed to help the user examine the evidence supporting the presence of and location of modifications in a selected protein. The view can be reached either by clicking the Proteins icon on the Navigation bar or from the PTM List view double clicking in any row in the PTM List table.

The view consists of two controls and four major panes, see Figure 7-1:

Controls:
1. “Proteins list” on page 93.
2. “PTM Sites List:” on page 93.

Panes:
1. “Sequence Coverage Pane” on page 94.
2. “PTM Sites Pane” on page 94.
3. “Sequence Coverage Pane” on page 94.
4. “The Ascore Algorithm Pane” on page 100.

Figure 7-1: Scaffold PTM Proteins View

Note that all tables, graphs and panes in the view include the features and tools described in section “Display pane” on page 66.
Proteins list

Through this pull-down list, the user may select a protein for display without switching views.

*Figure 7-2: Proteins pull-down list*

The blue box displays the name of the currently selected protein. Clicking in this box expands the list. Moving the mouse up and down over the expanded list highlights the proteins, and clicking selects the highlighted protein and updates the other panes of the view appropriately.

PTM Sites List:

This pull-down menu lists all of the PTM sites identified by the search engine in the selected protein. Each entry consists of a letter identifying the modified amino acid and a number indicating the position of the modification in the protein sequence, along with the type of modification found at that site. Choosing one of these sites selects the peptide containing the amino acid in the Protein Sequence pane and populates the panes in the right side of the Proteins View with localization information for this PTM site.

Selecting a specific amino acid in the Protein Sequence pane also changes the selection in the PTM Sites List. If an amino acid with an identified modification is selected in the protein sequence, the corresponding modification site is selected in the PTM Sites control. If the selected amino acid does not have a modification assigned to it, the amino acid and its position are shown with no modification type.

*Figure 7-3: PTM Sites list*
Chapter 7
The Proteins View

Sequence Coverage Pane

In the upper left quadrant of the Proteins View, this pane depicts the sequence coverage of the protein in each sample, as well as the overall sequence coverage for all samples combined. Bars represent the full sequence of the protein. Areas corresponding to portions of the sequence for which peptides were detected are colored. The first bar represents the cumulative coverage including peptides from all samples, and the remaining bars are individual depictions of the coverage in each sample.

PTM Sites Pane

This table lists all peptides containing the selected amino acid and provides information about the modifications that have been identified by the search engine in them. Each row in the table represents a spectrum, and the columns provide information about the peptide-spectrum matches to help the user manually validate the spectra. Most importantly, each row provides the Localization Probabilities and Ascores for the modifications in the peptide represented in the row.

Note that spectra are shown in the PTM Sites Pane even if they do not meet the Min. Localization Probability Threshold or if their modification types are not Visible. Under these circumstances, the modification sites are removed from the protein sequence, but the spectra are not removed from the PTM Sites table.

The columns in the PTM Sites table are:

- **Peptide Sequence**--Amino acids that carry modifications are designated by a lower-case letter. The selected amino acid is highlighted in each peptide in the table. The total number of highlighted lower-case letters in the table corresponds to the sum of the Number of Modifications identified in the included samples in The Mod List Table.

- **Variable modifications**--List of modifications identified by the peptide spectrum. They are designated by the type of modification, the amino acid that carries them and their location along the peptide.

- **Localization Probability**--Probability assigned to the modification pres the peptide. The way the probability is calculated is explained in section “Automated PTM Site Localization in Scaffold PTM” on page 25.

- **Ascore**--Ambiguity score for the modification site assignment, see “Automated PTM Site Localization in Scaffold PTM” on page 25.

  NOTE: an Ascore of 1,000.00 means that there is no uncertainty in the position of the modification. This happens when there is only one amino acid capable of undergoing the modification. In this case, the linear spectrum appearing in the lower portion of The Ascore Algorithm Pane will not be visible since it would serve no function.

- **Peptide Score**--Calculated as part of the Ascore calculation, the peptide score is a probability-based ion matching score. It is the cumulative binomial probability based on the potential number of b and y ions and the number matched. The peptide score reported is the maximal score calculated over all peak depths.
• **Search Engine scores**--one or more columns report search engine scores and the Scaffold peptide probabilities if the MZID were exported from Scaffold.

• **NTT**-- Number of termini consistent with the enzymatic cleavage rules for the enzyme used. It stands for number of tryptic termini, but the enzyme need not be trypsin.

• **Mass measurements** --
  
  - **Actual Mass** -- Peptide mass in Daltons obtained by multiplying the charge by the observed M/Z with the mass of one proton subtracted from it.
  
  - **Observed Mass** -- Mass over charge (M/Z) of the parent or precursor ion measured by the mass spectrometer.
  
  - **Charge**-- Peptide charge
  
  - **Delta AMU** -- (Actual Mass - Theoretical Peptide Mass) in Daltons, where the Theoretical Peptide Mass or Calculated peptide mass, is given by the sum of the masses of the amino acid residues in the peptide plus the mass of a water molecule.
  
  - **Delta PPM** -- (Actual Mass - Theoretical Peptide Mass) in PPM also referred to in the spectrum as the Parent error. It is calculated by dividing the delta mass expressed in Daltons by the Actual Mass and then multiplying by one million.

• **Start** --Peptide start index

• **Stop** --Peptide stop index

• **Fixed Modifications** -- List of fixed modifications identified in the peptide

• **Spectrum Name** -- Name of the spectrum matched with the peptide

• **MS Sample** -- Mass spec sample that includes the spectrum

When a row is selected, it is highlighted in blue and the information appearing in The Ascore Algorithm Pane is updated accordingly.

### Sequence Pane

The Sequence Pane shows an overall view of the best scoring PTM assignments highlighted in the selected protein sequence. Color coded schemes are used to convey information about the type of each modification, its localization along the peptide chain and the degree of confidence with which it is localized.

Right-clicking in the Sequence Pane displays a context menu that allows the user to adjust the sequence display. Selecting the first menu item, Display, brings up a submenu that offers three options for displaying the positions of the modified peptides in the protein sequence. These display modes are:
Chapter 7
The Proteins View

Figure 7-4: Selecting the Sequence Display Method

Spectral Coverage Mode

In Spectral Coverage mode, the pane displays the amino acid sequence of the selected protein, its identified peptides, which are highlighted in gray, and its identified PTM sites. The modifications appear as circles above their associated amino acids. The intensity of the color filling the circle reflects the modification’s highest localization probability for the particular site. Hovering over the modification triggers a tool tip that contains the coordinates of the amino acid in the sequence, its highest localization probability, and the samples in which it is found.

Figure 7-5: modifications in Spectral Coverage mode

Stacked Mode

In stacked mode, color-coded bars representing the presence of a peptide in a specific MS Sample are placed above the protein sequence. This mode is helpful in comparing coverage in different samples. The colors correspond to the sample colors in the Sequence Coverage Pane above.
Figure 7-6: modifications in Stacked mode

<table>
<thead>
<tr>
<th>MS Sample</th>
<th>Attribute</th>
<th>Protein Sequence Coverage</th>
<th>Spectral Matches</th>
<th>Cov %</th>
</tr>
</thead>
<tbody>
<tr>
<td>1_065327_Fly_Embryo_8a_2006</td>
<td>1</td>
<td>1</td>
<td>1%</td>
<td></td>
</tr>
<tr>
<td>1_06521_Fly_Embryo_3a_2006</td>
<td>1</td>
<td>1</td>
<td>7%</td>
<td></td>
</tr>
<tr>
<td>1_06532_Fly_Embryo_7a_2006</td>
<td>1</td>
<td>1</td>
<td>2%</td>
<td></td>
</tr>
<tr>
<td>1_065323_Fly_Embryo_5a_2000</td>
<td>1</td>
<td>1</td>
<td>5%</td>
<td></td>
</tr>
<tr>
<td>1_06522_Fly_Embryo_fe_2005</td>
<td>1</td>
<td>1</td>
<td>10%</td>
<td></td>
</tr>
<tr>
<td>1_06522_Fly_Embryo_fe_2005</td>
<td>1</td>
<td>1</td>
<td>7%</td>
<td></td>
</tr>
</tbody>
</table>

Overlay Mode

In overlay mode, the identified peptides are highlighted with the colors corresponding to the MS Samples in which the peptides are identified. When a peptide is in more than one sample, the colors blend.
Chapter 7
The Proteins View

Figure 7-7: modifications in Overlay mode

The Protein Sequence pane depends on the selected Min. Localization Probability and the
Visible Modifications pull-down list.

Selecting an amino acid in the sequence highlights the peptide which contains it and triggers
an update of the other panes in the view.

- If the selected amino acid is not highlighted, it means that no peptides were associated
  with it and the rest of the panes are empty.
• When the selected amino acid belongs to a highlighted sequence, the other panes display information about the amino acid and its associated peptides, see “PTM Sites Pane” on page 94 and “The Ascore Algorithm Pane” on page 100.
The Ascore Algorithm Pane

This pane provides the core statistical information used to compute the Ambiguity score (Ascore), based on the Algorithm developed by Beausoleil et al., see http://www.ascore.med.harvard.edu.

The pane contains two tabs:
- Spectrum and Ascore tab
- Peptide Score tab

Spectrum and Ascore tab

This tab includes two graphical tools: the spectrum that identifies the peptide selected in PTM Sites Pane and below it one or more Bar Graphs consisting of vertical lines that match the peaks in the spectrum. Each graph represents the spectrum at the peak depth which produced the highest peptide score. The lines that correspond to the site-determining ions used for the Ascore calculation are color coded by ion type. Blue lines correspond to the significant y-ions, while red lines correspond to significant b-ions, in the case of CID fragmentation.

The number of bar graphs shown depends on the number of ambiguously localized modifications. Above each graph, the modification and the calculated Ascore are listed along with the localization probability and the number of site-determining peaks present in the spectrum out of the total possible at a particular peak depth.

Figure 7-8: Spectrum and Ascore tab
Peptide Score tab

The Peptide Score Tab provides visual confirmation of the calculations of the Peptide Score and the Ascore, which measure a modification’s likelihood of being on one amino acid rather than another. If there is more than one ambiguously located modification in the peptide, this tab will contain a sub-tab for each modification.

In order to calculate the Peptide Score, the spectrum is first divided into a series of windows. Then, a series of simplified spectra is formed by sampling the original spectrum at peak depths from 1 to 10. To construct a spectrum at peak depth N, the algorithm chooses the N most intense peaks from each window.

The modification sub-tab shows a series of 2D plots of the Peptide Ions Score\(^1\) (Peptide Score) as a function of the peak depth used to calculate it. There is one plot for each potentially modified amino acid in the identified peptide. The earliest (in case of ties) peak depth that provides the largest separation between the highest-scoring and second highest-scoring modification sites is selected as the optimal peak depth for localization. In the graph, the optimal peak depth is indicated by a vertical dashed line. The legend on the right side of the graph identifies each curve with a corresponding peptide candidate that shows a particular combination of assigned modified amino acids.

Figure 7-9: Peptide Score tab

Chapter 7
The Proteins View

The Ascore is then calculated by computing the cumulative binomial probability using only the site-determining ions at the optimal peak depth.
The Motifs View identifies common sequence patterns, Motifs, surrounding modified sites in order to determine which enzymes may interact with the protein at the identified modification sites.

This chapter describes the functionality and purpose of the view:

- “The Motifs View” on page 104
Chapter 8
The Motifs View

The Motifs View

This view implements the motif identification approach of Schwartz and Gygi\textsuperscript{1}, in which biologically relevant motifs are extracted from sequence information from proteomics experiments. For a brief description of the algorithm as implemented in Scaffold PTM, see “Motif Identification” on page 27.

The view can be reached by clicking the Motifs icon on the Navigation bar or from the main menu by selecting the command View > Motifs.

A motif search is run automatically if the motif background setting is “Use Identified Proteins Only” or if a FASTA Database has already been configured for use as a background database. Background settings are changed and FASTA files configured through the dialog opened by selecting Edit>Preferences>Motif Background.

Within the view, the available tools and features are grouped into three different panes, see Figure 8-1:

1. “Motif pane” on page 105
2. “Sequences: pane” on page 110
3. “Motifs representation pane” on page 111

The tables in the first two panes share the properties of all tables in Scaffold PTM, see “Display pane” on page 66.

Figure 8-1: Motifs View

\textsuperscript{1} Schwartz, D. & Gygi, SP (2005) Nature Biotechnology 23(11):1391-1398
Chapter 8
The Motifs View

Motif pane

Scaffold PTM compares the sequences surrounding modified amino acids in the current experiment to the sequences surrounding the same amino acids in a background database. Sequences which appear significantly more often surrounding a modification than they do around the same amino acid in the background are identified as potential motifs. These motifs are reported in the Motif pane. Motifs are assigned scores based on how much more likely they are to appear in conjunction with modifications than would be expected if modification sites were chosen randomly from all possible sites in the background sequences. These scores are shown in the Motif pane, along with the number of modified peptides displaying the motif and the frequency of occurrence in the experiment and in the background. In addition, the Motif pane annotates motifs that have been previously reported in association with specific enzymes.

NOTE: Scaffold PTM can identify motifs based on one of two background database options, selected in the “Motif Background tab” on page 55. The options available are: “Use Identified Proteins Only,” and “Use FASTA Database (More Robust).”

Scaffold PTM uses the Human Protein Resource Database in order to identify the enzymes that interact with the modification sites associated with a motif.

The Motif pane includes the following tools, see number 1 in Figure 8-1:
- The Modification filter. - Filters a specific modification type.
- The Motif Tool bar --Provides tools to augment the motif search.
- The Identified Motifs table--Shows the list of identified motifs and related information.

Modification filter

This tool is used to help visualize the motifs and enzymes associated with a specific modification type. The filter is a pull-down list, and includes all modifications identified in the current dataset. Each entry in the list shows the type of modification, the modified amino acid and the mass of the modification.

When a modification is selected, the tool filters all identified motifs based on the selected modification type. The other panes in the Motifs view are influenced by the filter.

Motif Tool bar

The Motif Tool bar is located at the top right corner of the Motif pane, see number 1 in Figure 8-1. It includes four action icons. Scaffold PTM which can facilitate motif analysis.

Figure 8-2: Motif Tool bar.
The Motifs View

Add Motif...

The Add Motif... dialog allows the user to add Motifs to the identified motifs list. This can be done either adding a known enzyme specific motif, which might be appropriate if there is outside information to implicate an enzyme in a modification or adding motifs by hand.

Figure 8-3: Add Motif... dialog.

The dialog can be reached by clicking the “Search Subset Motif” action icon located in the “Motif Tool bar” on page 105.

It includes the following components:
• **Selected Modification:** - pull down list of the modifications present in the experiment
• **Choose Motif Type:** - provides the following two options for adding new motifs to the identified motifs list.
  • *Known enzyme specific motifs* - pull down list of known motifs
  • *Other Motifs* - Text box for the manual input of a new motif sequence to be searched. NOTE: the input character sequence should have all modification sites lower-case and the flanking sequences should be UPPER-CASE. It is possible to bracket a pair of amino acids, for example [DE], to signal that the amino acid present could be either D or E.
• **Action buttons:**
  • *Cancel* - Cancels the operation and closes the dialog.
  • *Add* - Searches for new motifs as instructed and closes the dialog. When no motifs are associated with a specific modification and enzyme pair a warning appears after selecting Add.

When adding a new motif the user should:
1. Choose the modification of interest from the selected modification list.
2. Either choose a type of enzymatic motif or add it manually.
3. Click Add.
4. A warning will appear if the selected pair does not have associated Motifs.

**Add Subset Motif...**

The Add Subset Motif... dialog allows the user to define motif searches performed with a custom subset of identified PTM sites, defined through selection from the PTM Sites table, as the foreground over the choice of an appropriate background dataset defined through the Analysis Background list. When using "All non-foreground PTM sites" as a background (this only applies to subset motif analysis), the Background dataset will be filtered to only include sites that were identified as having the motif’s modification on the same residue as the motif.

Note that it is not possible to search for known motifs in a subset of PTM sites.
Chapter 8
The Motifs View

Figure 8-4: Add Subset Motif… dialog

This dialog can be reached by clicking the “Search Subset Motif” action icon located in the “Motif Tool bar” on page 105. It includes the following components:

- PTM Sites table
- Analysis Background list

PTM Sites table

The table provides a list of all identified PTM sites in the experiment from which the user can select the set of identified PTM sites of interest by checking appropriate rows, or by selecting several rows, right clicking, and choosing “Use selected” from the popup menu, see Figure 8-4.

Each row in the table represents an identified PTM site with a check box for selection and information to help the user characterize the site.

The list of columns included in the table is:

- **Use?** - Check box. All selected rows constitute the identified PTM sites subset
- **Modification** - Type of modification
- **Surrounding Sequence** - Representation of the modification site, shown in lower case, surrounded by a six amino acid flanking sequence on each side shown in upper case letters
- **Accession** - Protein accession number where the PTM site is found
- **Name** - Protein name where the PTM site is found
- **Site** - PTM site location and type
- **Best Ascore** - Color coded according to...
- **Localization Probability** - Color coded according to...
Analysis Background list

This is a pull-down list from which the user can select the background for the motif search. In addition to the option of using identified protein sequences, or (if configured) a FASTA file, when performing a subset motif search, the user may also use the remainder of identified PTM sites as the background dataset. This choice is appropriate for some experimental designs where it is desirable to control for statistical effects of the sample preparation and identification, for example, when combining (modified) proteins of interest with a complex background mixture.

When using "FASTA Database" or "Identified Proteins" as the Background source, Scaffold PTM will consider ALL sequences in the protein surrounding the given residue, as it has no information about which of these are truly PTM sites. This is typically the desired behavior when doing motif discovery, as the motifs then represent the sequences that are "responsible" for some sites being modified.

When using "unselected PTM sites" as a background (this only applies to subset motif analysis), the Background dataset WILL be filtered to only include sites that were identified as having the motif's modification on the same residue as the motif.

The following are the possible Background choices:

- **All non-foreground PTM sites** - The remainder of identified PTM sites
- **Proteins identified in Search** - All proteins listed in The Mod List Table.

Identified Motifs table

This table provides a list of all Motifs identified in the experiment against a background database chosen from the Motif Background tab located in Edit > Preferences. For each identified motif, the table provides information to allow the user to assess the validity and biological relevance of the motif identification.

**Note:** By default, motifs are listed by their Motif Score from highest to lowest.

For each identified motif the table includes the following properties listed as columns:

- **Modification** - type of modification
- **Motif** - Motif description
- **Score** -
- **# Matches** -
- **Enzyme** -
- **Enzyme type** -
- **Citation** -
- **Dataset %** -
- **Background %** -
- **Foreground Origin** -
Chapter 8
The Motifs View

• **Background Origin** -

NOTE: Scaffold PTM details motifs based on one of two background database options displayed in the “Motif Background tab” on page 55. The options available are: “Use Identified Proteins Only,” and “Use FASTA Database (More Robust).”

Scaffold PTM uses the Human Protein Resource Database in order to identify the enzymes that interact with the modification site associated with a motif.

**Sequences: pane**

The Sequences Pane details, for the selected motif, each identified modification and its flanking sequences in the protein.
Motifs representation pane

The Motifs Representation Pane creates a graphic representation of the probability that an amino acid might exist in each specific position in a selected motif. Potentially significant modification trends that Scaffold PTM did not recognize may become apparent here.

The visual representation centers the modification of the selected motif (serine, in Figure 8-5) and displays the 12 flanking amino acids in the sequence, 6 on each side of the modification.

**Figure 8-5: Motif graphic representation**

![Motif graphic representation](image)

Scaffold PTM scales each representative letter by the with which it appears in the flanking sequence of a motif. The amino acids are color-coded by chemical property, see Figure 8-6.

**Figure 8-6: Chemical Properties color code**

<table>
<thead>
<tr>
<th>Chemical Property</th>
<th>Amino Acids</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydrophobic</td>
<td>All MV</td>
<td>Black</td>
</tr>
<tr>
<td>Basic</td>
<td>HKR</td>
<td>Red</td>
</tr>
<tr>
<td>Special AA</td>
<td>GP</td>
<td>Green</td>
</tr>
<tr>
<td>Alcohol</td>
<td>ST</td>
<td>Light Blue</td>
</tr>
<tr>
<td>Cysteine</td>
<td>E</td>
<td>Yellow</td>
</tr>
<tr>
<td>Acidic</td>
<td>DE</td>
<td>Blue</td>
</tr>
<tr>
<td>Polar</td>
<td>NQ</td>
<td>Pink</td>
</tr>
<tr>
<td>Aromatic</td>
<td>FWY</td>
<td>Purple</td>
</tr>
</tbody>
</table>
Chapter 9
The Quantify View

The Quantify View provides three different options for quantifying and analyzing the degree of modification at specific residues in specific proteins, and two options for quantifying differences in modification patterns within peptides.

“The Quantify View” on page 114
The Quantify View displays quantitative data for a single protein. When the Quantify View opens, it respects the protein selection of the other views. A different protein may be selected from the pull-down menu at the top of the pane. Next to the protein selection control is another pull-down that allows the user to select the Display Type.

When an MZID data file is exported from Scaffold or directly from a supported search engine, the quantitative information appearing in Scaffold PTM is based only on label free spectral counting methods and the only active tabs are the PTM Spectrum Count tab and the Peptide Spectrum Count tab, see Figure 9-1.

Depending on the type of quantitative data loaded into Scaffold PTM, however, the Quantify view may display three additional tabs. If quantitative data exported from Scaffold Q+ or Q+S in the SQML format has been loaded, Scaffold PTM offers quantitation based on isobaric or stable isotope labeling or on precursor intensity, and the PTM Quantitation, Peptide Quantitation and Quantitative Charts tabs are enabled.

Scaffold PTM can also adjust quantitative ratios to account for differences in protein level and give a more accurate measure of differential modification if a ProteinQuant.xml file is loaded into the experiment. This file must be exported from Scaffold Q+ or Q+S and should be derived from unenriched samples. It can be imported through the Experiment>Import Protein Quantitation Results... option. When protein quantitative data is available an additional figure, the Protein/Modsite Scatterplot, is added to the Quantitative Charts tab.

List of tools in the Quantify View:

- “Quantitation: Protein List” on page 116
- “PTM Spectrum Counts tab” on page 117
- “Peptide Spectrum Counts tab” on page 117
- “PTM Quantitation tab” on page 119
- “Peptide Quantitation tab” on page 120
- “Protein Level Normalization” on page 121
- “Quantitative Charts tab” on page 121
Figure 9-1: Quantify View.
Chapter 9

The Quantify View

Quantitation: Protein List

The Quantify view shows information related to a specific protein. The view can be reached either by double clicking on a protein in the The Mod List Table or by clicking on the Quantify button on the left side of the Scaffold PTM window. When the view opens it displays spectral counting data related to the selected protein in the PTM List view.

In the Quantify View, the **Quantitation:** pull-down list provides a method for selecting a different protein without returning to the PTM List view.

*Figure 9-2: Quantitation: Protein List.*
PTM Spectrum Counts tab

The PTM Spectrum Counts Tab offers semi-quantitative estimates of PTM abundances. It displays label-free, unweighted counts of spectra with assigned PTMs at a specific site for each MS Sample. The PTM Spectrum Counts tab gives an estimate of the relative occurrence of the PTM at the selected level of summary.

If the data loaded into Scaffold PTM is labeled or has precursor intensity data and is exported from Scaffold Q+, more reliable quantitative information is available through other tabs, but this view gives evidence for the values in the PTM Quantitation tab.

Five Display Types are available through the Display Options pull-down. By default, the Modified Count displays the number of spectra containing identified modifications of the specified type at the specified location. Another option, Modified Count/Total, shows the Modified Count, but also shows the total count of spectra spanning that location in the sequence. This provides an estimate of the relative degree of modification at a given site in various samples.

The remaining three display options show an estimate of the Total Ion Current (TIC). The reported TIC value of an MS2 spectrum is the sum of the intensities of all ions in the spectrum. The Total TIC is the sum of the TIC values of all spectra containing the specified modification at the specified site. Average TIC is the mean of these values, and Top 3 TIC sums only the three highest TIC values of spectra containing the indicated modification. If there are fewer than three spectra with the modification, Top 3 TIC is the sum of TIC values of the spectra that do meet the criteria.

Peptide Spectrum Counts tab

The Peptide Spectrum Counts tab is organized by peptide sequence and modification pattern, as identified by the search engine. It allows the user to compare the degree of modification between samples on a peptide level. It displays label-free unweighted counts of spectra with assigned PTMs within a specific peptide for each MS Sample. It also allows summarization to the Biological Sample or Biological Category level.

As in the PTM Spectrum Counts tab, five Display Types are available through the Display Options pull-down. By default, the Modified Count displays the number of spectra identified with the indicated peptide sequence and containing identified modifications in the specified locations. Another option, Modified Count/Total, shows the Modified Count, but also shows the total count of spectra identified with the specified peptide sequence, regardless of modifications.

The remaining three display options show an estimate of the Total Ion Current (TIC). The reported TIC value of an MS2 spectrum is the sum of the intensities of all ions in the spectrum. The Total TIC is the sum of the TIC values of all spectra matching the specified peptide sequence and modification pattern. Average TIC is the mean of these values, and Top 3 TIC sums only the three highest TIC values of spectra containing the indicated modification. If there are fewer than three spectra with the modification, Top 3 TIC is the sum of TIC values of the spectra that do meet the criteria.
Chapter 9
The Quantify View

Summarization of Spectral Counts

Scaffold PTM offers the option to view spectral counts on the MS Sample, Biological Sample, and Biological Category levels. The default Summary Level is set to the “MS Sample” level as shown in the experiment depicted in Figure 9-1, where six MS Samples are loaded into the application. The various MS samples are displayed to the right of the Localization Probability.

The user may change the level of summarization through the Summary Level pull-down list in the Summarization bar.

When data is exported from Scaffold, the user can define Biosamples and Categories in that application before exporting the MZID. Otherwise the summarization levels can be defined and assigned in the “MS Sample Data pane” on page 78.

Figure 9-3: Spectrum Count tab change of summarization level

The data is summarized in a table where each row represents a PTM site or a peptide. A number of columns provide scores associated with the PTM site or peptide and the spectral counts are reported at the selected level of summarization.

- **Site** - coordinates along the protein sequence and type of modification
- **Modification** - Type
- **Best Ascore** - score value
- **Localization Probability** - Best probability
- Quantitative values per MS sample or summarization level.
PTM Quantitation tab

The PTM Quantitation Tab shows PTM abundance values imported from Scaffold Q+ or Scaffold Q+S analysis. The data is organized in a table containing identified PTM sites in the selected protein which meet the current filter conditions. The tab only appears if quantitative SQML data is loaded.

Scaffold Q+ and Scaffold Q+S calculate the reference values using quantitation options selected by the user before exporting SQML data. The PTM abundance is calculated by comparing the median $\log_2$ of the fold change measurements for each PTM site in every sample to the reference value. The reference value is the average (median or mean) peptide abundance measurement in the reference sample. For more information on how to create SQML data files see “ScaffoldQuantML exports” on page 42.

**Note:** Scaffold PTM does not consider PTM sites that score below the selected Minimum Localization confidence level in this calculation.

Scaffold PTM also offers statistical measures to assess the significance of the fold change value computed for each modification site. These values are displayed under this tab and in the Volcano Plot.

*Figure 9-4: Quantitation tab*

When SQML data files from Scaffold Q+ or Scaffold Q+S are loaded, Scaffold PTM stores the quantitative ratios computed by Scaffold Q+ or Scaffold Q+S for every spectrum.

These values are then used to compute a fold change for each modification site in the experiment by taking the median fold change across all spectra in a given sample that were identified as a peptide containing the specific modification at that site.
Chapter 9
The Quantify View

These median fold change values are displayed in the table included in this tab.

To see details of the calculation of modification site fold changes, the user can hover the mouse over a ratio value and see every underlying fold change associated with the specific site, see Figure 9-4.

When viewing data at the Summary Level of Biological Samples or Categories, the computation is analogous, but with a slight difference. The displayed values are the median fold changes for all spectra within that Quantitative Sample or Category. Note that spectral counts are summarized at the BioSample level, while quantities derived from Scaffold Q+ or Q+S are summarized by the Quantitative Channel or Sample.

Peptide Quantitation tab

The Peptide Quantitation Tab shows modified peptide abundance values imported from Scaffold Q+ or Scaffold Q+S analysis. The data is organized in a table consisting of peptide sequences with identified PTM sites in the selected protein which meet the current filter conditions. The tab only appears if quantitative SQML data is loaded.

Scaffold Q+ and Scaffold Q+S calculate the reference values using quantitation options selected by the user before exporting SQML data. The modified peptide abundance is calculated by comparing the median $\log_2$ of the fold change measurements for each modified peptide in every sample to the reference value. The reference value is the average (median or mean) peptide abundance measurement in the reference sample. For more information on how to create SQML data files see “ScaffoldQuantML exports” on page 42.

**Note:** Scaffold PTM does not consider peptides that do not contain at least one PTM site that scores above the selected Minimum Localization confidence level in this calculation.

Scaffold PTM also offers statistical measures to assess the significance of the fold change value computed for each modification site. These values are displayed under this tab and in the Volcano Plot.

*Figure 9-5: Peptide Quantitation tab*
Protein Level Normalization

Both the PTM Quantitation tab and the Peptide Quantitation tab support an experimental design that assists in separating the effects of changing protein levels from changing patterns or levels of modification.

In this type of experiment, MS samples are obtained under similar conditions from PTM-enriched and unenriched samples. The PTM-enriched samples are loaded into Scaffold Q+ or Q+S, and the results are exported as an SQML file. The unenriched samples are loaded into a separate Scaffold Q+ or Q+S experiment, and results are exported as a Protein Quantitation XML Report. The SQML is loaded into Scaffold PTM, then the Protein levels are imported through the **Import Protein Quantitation Results...** option in the Experiment menu.

*Figure 9-6: Importing Protein Quantitative Results*

The program then prompts the user to align the protein quantitation samples with the enriched samples. The imported protein quantitative values are used to adjust the quantitative values in the PTM Quantitation tab or the Peptide Quantitation tab to better reflect differential modification by removing the effect of differential expression. For details, see Appendix C., “PTM Dynamic Quantitative Calculations,” on page 139

When Protein Quantitation information has been imported, the headers of the PTM Quantitation tab and the Peptide Quantitation tab add the notation: “(Protein Normalized).”

Quantitative Charts tab

This tab becomes available whenever the user loads SQML data. Depending on whether or not the loaded analysis includes protein relative quantitation, the tab will include one or two plots:

For any experiment containing quantitative data, the Quantitative Charts tab of the Quantify View contains a Volcano plot, showing the relationship between fold change and assessed statistical significance (computed as $-\log_{10}(p)$) for each modification site in the experiment. These values are computed for every sample at the current level of summarization, except for those in the Reference category, as described in Quantitative Statistics.

- Volcano plot
Chapter 9
The Quantify View

- Protein/Modsite Scatterplot

*Figure 9-7: Quantitative Chat tab*

Volcano plot

By default the volcano plot shows all samples simultaneously, but each sample can also be shown individually by selecting it from the drop-down menu above the plot. The plot also indicates the currently selected protein by surrounding the points for its sites with a yellow circle, and the selected site within that protein with a black outline. Selection can be changed by clicking points in the plot and will be reflected in the PTM Spectrum counts and PTM Quantitation tables, as well as the Proteins View. Selection indication can be disabled by right-clicking the plot and deselecting “Indicate selection”.

Protein/Modsite Scatterplot

When protein quantitation data is present in a Scaffold PTM experiment, the Quantitative Charts Tab of the Quantify View will contain a scatterplot of PTM sites, showing the relationship between the site’s quantitative ratio in each non-Reference-category sample (at the current level of summarization) and it’s protein-level quantitative ratio (both axes are in log2 space). By default the volcano plot shows all samples simultaneously, but each sample can also be shown individually by selecting it from the drop-down menu above the plot. The diagonal dashed line y=x indicates no change in PTM activity, while points far from this line have major changes in PTM quantity after controlling for protein expression.

The plot indicates the currently selected protein by surrounding the points for its sites with a yellow circle, and the selected site within that protein with a black outline. Selection can be changed by clicking points in the plot and will be reflected in the PTM Spectrum counts and PTM Quantitation tables, as well as the Proteins View. Selection indication can be disabled by right-clicking the plot and deselecting “Indicate selection”.

Chapter 10
The Publish View

This chapter provides detailed information about the Scaffold PTM Publish View.
- “The Publish View” on page 124.
The Publish View

The Scaffold PTM Publish View displays general and detailed information about the data loaded in the current experiment usually required for publication in a number of proteomics journals.

The Publish View contains two tabs:

- “Experiment Methods tab” on page 125
- “SQL Export tab” on page 126
Chapter 10
The Publish View

Experiment Methods tab

The Experiment Methods tab contains two panes:

- **Parameters pane** - located on the left side of the tab, this displays the parameters characterizing the current experiment. The information is organized in a tree-structured table that can be expanded or collapsed for ease of view. The pane also includes a text search tool for easily locating specific parameters of interest and a button that toggles the tree to an expanded or collapsed state.

- **Citations pane** - located on the right side of the tab are citations which a user will need when publishing results of a Scaffold PTM analysis.

Below the text window there are buttons that allow the user to copy the information or to Export the Publish report. These reports may be useful as supplemental data to support publication in a Proteomics journal.

*Figure 10-1: Experiment Methods Tab*
Chapter 10
The Publish View

SQL Export tab

The experiment files created by Scaffold PTM, *.sptm files, are essentially SQLite databases.

The SQL export tab is an SQLite graphical interface where a Scaffold PTM experiment file can be searched as a database using SQLite commands. The user can in this way create custom tables exportable to Excel.

A description of the general schema of a *.sptm file is shown in Structure of Scaffold PTM files (*.sptm).

Figure 10-2: The SQL tab

The SQL Export tab contains four different panes:

- The SQL pane
- The Saved Queries pane
- The Results pane
- The Icon bar

The SQL pane

Through the SQL pane it is possible to directly explore the information stored in a Scaffold PTM file using SQLite queries.

- The SQL text pane - where the user can enter, copy and paste SQL queries.
- The SQL Icon bar - which contains the Run Query button, the Save query as: text box and a Save button to save queries.
Chapter 10
The Publish View

The results of the queries are shown in The Results pane. The saved queries are listed in the The Saved Queries pane

Examples:
List of tables available in *.SFDB files.
SELECT name FROM SQLite_master WHERE type='table' ORDER BY name;

The Saved Queries pane
When the user names and saves a query, it appears listed in this pane from where it is conveniently available to be launched again whenever needed.

The Results pane
When the Run Query button is pressed, if there are no errors, a table with the query results appears in this pane. Clicking the Export Results button or selecting the right click menu option Export > Export to Excel..., saves the table in a CSV text format file that can be easily opened in Excel.

The Icon bar
The icon bar contains an icon to save new queries to a file that can be later retrieved and an icon to import previously saved queries.
Chapter 11

Reports

This chapter provides a list of the exports available in Scaffold PTM with a brief description of the information included in the exported file.

- “Scaffold PTM Reports” on page 130
Scaffold PTM Reports

A variety of reports are available in Scaffold PTM to assist the user in interpreting and analyzing quantitative data. All reports are available from the Export option on the Scaffold PTM main menu, see Figure 11-1. Each report is saved in a predefined format as a comma-separated text file, suitable for viewing and further analysis in Microsoft Excel.

The user cannot change the report format, but can always select a different location in which to save the report. When the user saves an Excel report, a default name in the format <Report Name><Scaffold File name> is provided for the report, but their values can be changed.

The following reports are available in Scaffold PTM:

- Exports compatible with Excel ................................................................. 131
- SQL Query Exports .................................................................................... 134
Exports compatible with Excel

Scaffold PTM provides a number of reports created in the CSV (Coma Separated Values) text file format. Each report contains a different type of information related to the analysis performed in the current Scaffold PTM experiment:

- Publish View report
- PTM List report
- Spectrum report
- Motifs report
- Quantify View reports
- Current View report

How to open Scaffold PTM reports in Excel:

The exported reports can be viewed in Microsoft Excel for further analysis of the data they contain. Any CSV file opens automatically in Excel if the application is installed in the computer system used.

To create an export that includes the GO annotations see PTM List report

Publish View report

PTM List report

The PTM List report mimics the PTM List View. Each row in the report represents a protein in the PTM List table. The modifications displayed in the columns depend on the filter settings specified in Min Localization and Visible Modifications. See the list of columns for Tutorial 3 in Figure 11-2.

Figure 11-2: PTM List report columns

<table>
<thead>
<tr>
<th>#</th>
<th>Star</th>
<th>Protein Name</th>
<th>Accession</th>
<th>Scaffold Protein Probability</th>
<th>Sequence Coverage</th>
<th>Acetylation (N)</th>
<th>Cl3 and N15 label (K)</th>
<th>Cl3 and N15 label (R)</th>
<th>Cl3 label (R)</th>
<th>Oxidation (M)</th>
<th>Phosphorylation (S)</th>
<th>Phosphorylation (T)</th>
<th>Phosphorylation (Y)</th>
</tr>
</thead>
</table>

Spectrum report

The Spectrum report details all of the spectra included in the MZID files loaded in the
experiment. Each row represents a spectrum matching a peptide. There are two types of spectrum reports:

- Spectrum report - which includes all the spectra loaded in the experiment
- Filtered Spectrum Report - Which includes spectra respecting the filter settings

*Figure 11-3: Spectrum report columns*

<table>
<thead>
<tr>
<th>Protein accession</th>
<th>Protein name</th>
<th>Peptide sequence</th>
<th>Variable modifications</th>
<th>Localization probability</th>
<th>Mascot Score</th>
<th>Mascot Ion Score</th>
<th>Scaffold peptide probability</th>
<th>NTT</th>
<th>Experiment start</th>
<th>Experiment stop</th>
<th>Fixed modifications</th>
<th>Spectrum Name</th>
<th>MS Sample</th>
</tr>
</thead>
</table>

**Column quick notes:**

- The first 2 columns of the table provide information identifying the protein.
- Next the peptide sequence is shown, followed by the list of variable modifications with their Ascores and localization probabilities and the search engine scores for the spectra. If data files were imported from Scaffold, the peptide probabilities are also included.
- Number of enzymatic termini (NTT). When the digestion enzyme is trypsin, this tells if the peptide is tryptic (2) semi-tryptic (1) or non-tryptic (0). It may represent the digestion rules for other peptides, however.

**Motifs report**

Exports most of the information from the table appearing in the **Motifs** pane

*Figure 11-4: Motifs report columns*

<table>
<thead>
<tr>
<th>Motif</th>
<th>Motif score</th>
<th>Enzyme</th>
<th>Type</th>
<th>Cation</th>
<th>Surrounding sequence</th>
<th>Accession</th>
<th>Site</th>
<th>Best Ascore</th>
<th>Localization probability</th>
</tr>
</thead>
</table>

**Quantify View reports**

The Quantify View reports menu item offers an assortment of options reflecting the various tabs in the Quantify View. Each option generates a report with the same information that appears in the corresponding tab, but the export includes information for all proteins currently meeting thresholds in the experiment.
When the Export PTM Spectrum Counts Report to Excel or the Export Peptide Spectrum Counts to Excel option is selected, an additional dialog appears, prompting the user to specify which Display Type should be used in the report. The options correspond to the Display Types available in the corresponding tabs in the Quantify View. If the Modified Count/Total option is selected, the Modified Counts and Total Counts are displayed in separate columns.

When the Export PTM Quantitation Report to Excel or the Export Peptide Quantitation Report to Excel option is selected, the user is prompted to select a format for displaying the ratio data reported in the export.

Current View report

The Current View report contains the information that is displayed in the current view. This report is applicable for all Views.
SQL Query Exports

Run SQL Query for Export...

This option allows the user to create a custom report using SQL. Selecting this option opens the SQL Report tab of the Publish View, see “SQL Export tab” on page 126.
The Appendix provides more detailed information about the structure and algorithms utilized in the Scaffold PTM application.

- “Appendix” on page 136
Appendix

• Appendix A. Structure of Scaffold PTM files (*.sptm)
• Appendix B. Terminology
• Appendix C. PTM Dynamic Quantitative Calculations
• Appendix D. Context Menus - Right Click Commands
Appendix A. Structure of Scaffold PTM files (*.sptm)

The Scaffold PTM file (SPTM) is a SQLite database. For a larger version of the schema, see Appendix A of the Scaffold PTM User’s Guide.

Figure 1:
Appendix B. Terminology

Blocking
When groups of experimental units are similar, it is often a good idea to gather them together into blocks. By blocking the variability attributable to the differences between the blocks is isolated so that the differences caused by the treatments appear more clear.

Contingency table
In statistics, a contingency table (also referred to as cross tabulation or cross tab) is a type of table in a matrix format that displays the (multivariate) Frequency Table or distribution of the variables.

Experiment (a statistical definition)
An experiment manipulates factor levels to create treatments, randomly assigns subjects to these treatments levels, and compares the responses of the subject groups across treatment levels.

Factor
A variable whose levels are manipulated by experimenters. It is a single biological or technical parameter that the user controls in an experiment like gender, diet, environment, stimulus, age and so on. Experiments attempt to discover the effects that differences in factor levels may have on the responses of the experimental units.

Frequency Table
In statistics, a frequency table is a table that displays the frequency of various outcomes in a sample. Each entry in the table contains the frequency or count of the occurrences of values within a particular group or interval, and in this way, the table summarizes the distribution of values in the sample. Bivariate joint frequency distributions are often presented as (two-way) Contingency tables.
Appendix C. PTM Dynamic Quantitative Calculations

Scaffold PTM 3 introduced new features to enable quantitative analysis of PTM activity by simultaneously considering protein- and site-level changes within an experimental condition. Previously, Scaffold PTM could import quantitative ratios computed by Scaffold Q+ and Scaffold Q+S and compute fold change ratios for individual PTM sites (see PTM Quantitation tab and Quantitative Statistics). However, these ratios reflected two distinct processes: up-/down-regulation of the whole protein (which affects quantitative measurements for all of the protein’s peptides), and up-/down-regulation of a specific PTM site (which only affects measurements of the peptide(s) containing that site). This means that distinguishing which changes in PTM activity are present in an experiment requires a way of deconvolving these two effects. The simplest way of doing so is to directly measure any whole-protein quantitative changes, generally by analyzing a second preparation of the same biological samples without PTM enrichment. The difference between the measured PTM site ratios and whole-protein ratios then gives a measurement of the change in PTM activity.

Details of Quantitative Calculations

Let’s consider that under some experimental condition, a protein P has a quantitative fold change $FC_p = p/q$, and that for some PTM site S in the protein we measure a fold change $FC_S = r/s$. Intuitively, this says that we observed $p$ copies of the protein and $r$ copies of the (modified) peptide under the experimental condition, while we measured $q$ and $s$ copies of the protein and peptide (respectively) in the reference sample. Thus, for every copy of the protein, we observed $r/p$ copies of the peptide in the experimental condition, and $s/q$ in the reference sample. We can then compute the change in PTM activity by the ratio:

$$\frac{r/p}{s/q} = \frac{r \cdot q}{s \cdot p} = \frac{FC_S}{FC_p}$$

Because we do our calculations in $\log_2$ space, the ratio of ratios may be computed as a difference:

$$\log_2 \left( \frac{FC_S}{FC_p} \right) = \log_2 (FC_S) - \log_2 (FC_p)$$

When displaying quantitative ratios at higher levels of summarization, this normalization is applied to each measurement at the MS Sample level, and then the median of all the protein-normalized ratios in the Biological Sample or Category is computed for display. These pre-protein normalized values are also used when computing Quantitative Statistics.
Appendix D. Context Menus - Right Click Commands

- **Blast Peptide Sequence** - open an internet browser and launch a Blast search for the peptide sequence.
- **Blast Protein Sequence** - open an internet browser and launch a Blast search for the protein sequence.
- **Copy** - copies selected data in a table.
- **Copy All Data** - copies all the data listed in the table shown in the current pane to the clipboard.
- **Copy Chart data** - Copies data plotted in the selected chart
- **Copy Image** - copies the image of the current view and current pane to the clipboard.
- **Copy Peak List** - Copies the peak list of current spectrum to the clipboard.
- **Copy Publication Sized Image** - copies image to the clipboard for publication purposes.
- **Copy Selected Cell** - from the table copies selected cell to the clipboard.
- **Copy Selected row** - from the table copies selected row to the clipboard.
- **Copy Sequence** - copies the Protein Sequence as a text string.
- **Copy EMF (vector) image** - copies picture using Windows Meta-file formats which are portable between applications. They contain both vector graphics and bitmap components. Images can be edited and scaled without compromising their resolution.
- **Deselect Sample** - removes selected MS Sample(s) from the analysis.
- **Display Known Markers** - label the identified ions in the spectrum image.
- **Display Unknown Markers** - label unidentified peaks in the spectrum image with m/z values.
- **Draw Sequence above the Spectrum** - Move the “ladder” to a position above the spectrum image.
- **Edit Modification Colors** - Opens the color editor.
- **Enable Tooltip** - Toggles the presence or absence of tool tips appearing over peaks in the MS2 spectra.
- **Export to Excel...** - Export information in current table to Excel
- **Groups** - Expand or collapse protein groups.
  - **Expand All** -
  - **Collapse All** -
- **Indicate Selection** - highlight the selected protein in the Quantitative Plots.
- **Outline Mods** - Toggles between open and closed colored circles to highlight mods.
- **Print** - print image of current view and pane.
- **Print Protein** -
- **Save** -
  - **Save as** - Provides the option of saving pictures in a large variety of graphical formats.
  - **Save EMF (vector) Image** - Saves picture to file using Windows Meta-file formats which are portable between applications. It contain both vector graphics and bitmap components. Images can be edited and scaled without compromising their resolution.
  - **Save PNG (bitmap) Image** -
  - **Save SVG (vector) Image** -
- **Select All** - Selects all metabolites appearing in the Samples table
- **Set as Internal standard** - Tags internal standard metabolite
- **Show Isotope traces** - Shows red sticks over theoretical isotope peaks positions in the Isotopic Distribution graph.
- **Set Peak Depth** - Adjusts the spectrum image to show only the peaks that would be considered at a certain Peak Depth.
- **Show Toolbar** - Toggles toolbar presence in chemical structure drawing board.
- **Stars** - available star functionalities:
  - **Add Orange** - Adds an orange star.
  - **Add Blue** - Adds a blue star
  - **Remove Star** - Removes selected star
  - **Remove all stars** -
- **Show/Hide** - options available to change visual status of metabolites groups rows in the samples table. Typically used when a group of rows is selected.
  - **Show**
  - **Hide**
  - **Hide Others**
- **Use Blinking Cursor** - causes the selected peptide in the protein sequence to blink.
- **Use Peak Finder** - enables a tool that provides the m/z value when the mouse hovers over a peak in the spectrum image.
- **Use ppm Masses** - change the tooltip display of mass errors in the spectrum image from amu to ppm.
Appendix

- **Zoom In** (Ctrl+) -
- **Zoom Out** (Ctrl-) -
- **Zoom Out Fully** - Zooms out the graph to its original size.
Index

A
Assumptions for the manual ........ 8
automatic motif search ............ 104

C
Conventions used in the manual ... 7

I
Installation instructions ........... 12
Installing Scaffold PTM .......... 12

L
License key registration
   License key renewal ............. 18
   License keys .................... 13
   Licensing for Scaffold PTM .... 13

M
Min Localization threshold ........ 64
Minimum system requirements ... 19
Modified Count/Total, ............ 117
Motifs report ..................... 132

N
Neutral Loss Model ............... 44
Neutral Losses .................... 25

O
Organization of the manual ....... 8

P
PTM List report .................. 131
PTM List Table ................... 83
PTM List View ................... 82
PTM View
   PTM List Table ................. 83
Publication report ............... 131
   p-value ....................... 29

Q
Quantify View reports .......... 132

R
Recommended system requirements.......... 19
Registering license key
   No Internet connection .......... 17
   Renewal ....................... 18
Renewing time based license key 18
Reports ........................ 130
   Motifs ....................... 132
   PTM List ..................... 131
   Publication ................... 131
   Spectrum .................... 131

S
Samples View
   sorting feature ............... 84
Scaffold PTM
   Installation instructions .... 12
   Licensing .................... 13
   sorting feature
   Samples View ................ 84
Spectrum report ............... 131
Star filters .................... 89
Summarization Bar ............ 63

Summary Level - Quantitative values ........................................ 120
System Requirements
   Minimum requirements ........ 19
   Recommended requirements ... 19
System requirements ............ 19

T
TIC ................................ 117
Time based license key renewal .. 18
Total Ion Current ................ 117

U
Using the manual ................ 7

Scaffold PTM User’s Manual 1